


























































































































































































































































































































































































































































































































































































































Group 3 (cont.) 

<Collision 
Counter> 

softkey is used to assign the task of counting collisions 
to one of the 16 available counters. 

The collision counter is exclusively assigned to count collisions. 
You cannot increment that counter by another program 
command. The collision counter is not displayed as a softkey 
choice for <increment Counter> sof tkey. 

The <When> <Collision Counter> softkeys can be used in 
combination to detect when the number of collisions has 
exceeded some quantity. 

The example below detects how many collisions occurred in 
10 seconds. 

Store: all frames 
nonstop 

Block 1: 
Start timer Timer 0 

Block 2: 
Start collision counter counter_3 

Block 3: 
When timer Timer_O exceeds 10 seconds then go to Block 4 

Block 4: 
Stop timer Timer 0 

and then 
Stop Test 
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Group 3 (cont.) 

<Then Go To 
Block> 

<Else When> 

Block 6: 

lets you specify the block to branch to when the 'When' 
comparison is true. 

Enter a block number from the keyboard and press RETURN 
key to complete the program step. 

lets you select an alternative 'when' statement. 

The <Else When> command follows a <When (event)> 
command. 

The program first checks the status of the <When (event)> 
line. If the <When (event)> statement is false and if an <Else 
When> command follows, the program then checks the status 
of the <Else When> command. 

If the <Else When> condition is true, the program branches to 
wherever the <Else When> command directs. 

If the <Else When> condition is false, the program goes back 
to the <When (event) 

Example: 

When frame counter Count_Frames exceeds 100 then go to Block 7 
else When timer TIMER_O > 5 Seconds then go to Block 10 

In this example, the program first checks to see if the frame 
counter has exceeded 100. If the counter has exceeded 100, 
the program jumps to Block 7. 

If the counter has not exceeded 100, the program looks at the 
<Else When> command on the following line. If the timer is 
greater than 5 seconds, the program goes to Block 10. If the 
counter has not exceeded 5 seconds, the program returns to 
the previous program line. 
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Display Functions In < Edit Programs > Menu 

This section provides a summary for viewing data during a program run. Each of the 
program commands discussed in the following text have been described in the previous 
section, Program Command Descriptions. See the appendix section for the execution 
time for program instructions. 

During a program run, the default mode for the HP 497 lS is to not display data. This 
lets the protocol analyzer more easily keep up with traffic on the network during heavy 
network loads. 

As described earlier in this chapter, displaying frames or timers and counters slows the 
processor operation and may cause it to get behind in its task of capturing frames 
occurring on the network. When the processor gets behind, it halts the program run. 

See the appendix section, "Execution Time." This section lists the time to execute 
different program instructions. 

There are two modes of display available in programs: 

Selective Display 

Continuous. 

The selective display mode can be used to selectively display frames under program 
control. whereas the continuous display mode updates the display continuously under 
program control. 
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SELECTIVE DISPLAY MODE 

The selective display mode is activated by the <Display Frames> program command. 
This command causes a single frame (the last frame processed by the program) to be 
displayed in the format chosen in the <Examine Data> Menu. 

This selective display mode should be used when it is desirable to display rarely 
occurring frames while storing more frequently occurring ones. 

When the selective display mode is used, a dashed line will appear between frames to 
indicate they are not necessarily contiguous in the buffer. 

Example to: 

Problem: 

Program: 

Summary: 

Display Selected Frames 

You are running a protocol in which a certain frame type is an 
acknowledgment frame. You suspect that occasionally an 
acknowledgment is getting lost because it has a bad FCS or alignment 
error. To test this, use <Edit Filters> Menu to define an 
acknowledgment frame filter. Name the filter "ack_frame" and 
select <Frame Traits> softkey. Frame Traits should be selected to 
Accept bad FCS and Alignment errors. You will Re iect Good FCS 
and RUNT frames. With these frame traits selected, write the 
following program. 

Store: frames matching ack frame 
nonstop 

Block 1: 
When frame matches ack_f rame 

as well as Frame Traits then go to Block 2 

Block 2: 
Display frame 

and then 
Go to Block 1 

This program stores all "ack_frames" but only displays the frames 
also containing a frame error. 
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CONTINUOUS DISPLAY MODE 

The continuous display mode has two formats: 

Counters & Timers 

Frames 

Counters & Timers 

Counters & Timers is the recommended display mode since their values can be updated 
much faster than frames can be displayed. The continuous mode is accessed by using 
the <Start>< Display> program command. The command remains in effect until a 
<Stop> <Display> command is encountered. This mode should only be used for viewing 
data on a lightly loaded or heavily filtered network. 

The continuous display form defaults (at the start of a run) to the Counters & Timers 
display. Thus the first <Start> <Display> executed (with the exception described below) 
will begin displaying Counter & Timer data and keep updating this display until it is 
either stopped or changed. When this display format is active, the softkey <Display 
Frames> will appear and can be used to switch the display to Frames. 

Frames 

The continuous frame display will display all frames stored in the "Store" line as they 
are received. Since these will be contiguous in the buffer, no dashed lines appear 
between them. This form can be accessed in one of two ways: either by pressing the 
<Display Frames> softkey in the Counters & Timers display or by using the <Display 
Frame> command described in the selective display mode description. When a <Display 
Frame> command is executed in between a <Start> <Display> and a <Stop> <Display>, 
the display will start off in the Counters & Timers format and then switch to the 
frames display format. When operating in the continuous frames display, a softkey 
<Counters & Timers> is displayed and can be used to return to the continuous Counter 
& Timers display. 

The <Stop> <Display> command automatically switches the continuous display form 
back to Counters & Timers. Therefore, to switch back from the frame display mode to 
the Counters & Timers mode, you need only stop the display and then start it again. 

<Edit Programs> Menu 14-51 



Example to: 

Count Frames And Display Counters And Timers Continuously. 

Program: 

Example to: 

Program: 

Store: all frames 
nonstop 

Block 1: 
Start display 

and then 
Start frame counter all frame 

Display All Frames Continuously 

Store: all frames 
nonstop 

Block 1: 
Display frame 

and then 
Start Display 

<Edit Programs> Menu 14·52 



Example to: 

Problem: 

Program: 

display) 

Alternate Displaying Counters & Timers With Frames 

To count frames, display counters & timers for five seconds, 
switch to displaying frames for five seconds, and then switch 
back to counters & timers. 

Store: all frames 
nonstop 

Block 1: 
Start timer 5 secs 

and then 
Start frame counter alt frames 

Block 2: 
Start display (begins Counter & Timer 

and then 
When timer 5 secs exceeds 5 seconds then go to Block 3 

Block 3: 
Reset timer 5 secs 

and then 
Displ'ay frame 

and then 
(switches display to frames) 

When timer 5 secs exceeds 5 seconds then go to Block 4 

Block 4: 
Stop display 

and then 
Reset timer S_secs 

and then 
Go to Block 2 
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Programming Examples 

This section lists several example programs. These are simple programs that illustrate 
using timers, counters, messages and filters in programs. 

PROGRAM EXAMPLE 1. 

REQUlREMENT: 

CONDITIONS: 

You want to know how many network collisions and frames 
with bad FCS occur in a five minute period. 

You also want to mark all frames occurring with a bad FCS. 

You need to define the following items: 

A timer named DURATION 

A counter named CNT_FCS 

A filter named BAD _FCS 

When the program is completed, the protocol analyzer will display the Timers & 
Counters Menu. 
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PROGRAM 1: 

Store: all frames 
nonstop 

Block 1: 
Start timer DURATION 

and then 
Start collision cntr COLLISION 

Block 2: 
When timer DURATION exceeds 300 seconds then go to block 4 
else when frame matches BAD FCS then go to block 3 

Block 3: 
Increment counter CNT_FCS 

and then 
Mark frame 

and then 
Go to block 2 

Block 4: 
Start display 

and then 
Stop test 
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PROGRAM EXAMPLE 2. 

REQUIREMENT: 

CONDITIONS: 

You want to view your network for 60 seconds. During that 
time, you want to count how many times three different types 
of addresses occur in the frames seen. 

In addition, you will count the total number of frames 
received during the 60 second period. 

You need to define the following items: 

A timer named DURATION 

A counter named TOT FRAME 
A counter named CT_ GLOBAL 
A counter named CT_LOCAL 
A counter named CT_BROAD 

A filter named GLOBAL 
A filter named LOCAL 
A filter named BROADCAST 

The three filters test the address fields in each frame to see how they are administered. 
The address tests are: Local, Global, and Broadcast. 

The filters you define will use the Destination and Source Address Fields to determine 
what type of frame is being received. 
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PROGRAM 2: 

Store: all frames 
nonstop 

Block 1: 
Start timer DURATION 

and then 
Start frame counter TOT_FRAME 

Block 2: 
When timer DURATION exceeds 60 seconds then go to block 6 
else when frame matches GLOBAL then go to block 3 
else when frame matches LOCAL then go to block 4 
else when frame matches BROADCAST then go to block 5 

Block 3: 
Increment counter CT GLOBAL 

and then 
Go to block 2 

Block 4: 
Increment counter CT_LOCAL 

and then 
Go to block 2 

Block 5: 
Increment counter CT BROADCAST 

and then 
Go to block 2 

Block 6: 
Start Display 

and then 
Stop test 
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PROGRAM EXAMPLE 3. 

REQUIREMENT: 

CONDITIONS: 

You want to know how often a particular frame with 
Ethernet Type 06-00 occurs. You also want to know when a 
frame with a length or 500 bytes occurs. When either of these 
frames occur, you want to mark the frame. You need to 
know how many times these two events occur in a 60 second 
period. 

You need to define the following items: 

A timer named DURATION 

A counter named CT TYPE 
A counter named CT_ LENGTH 

A filter named TYPE_06_00 
A filter named LENGTH 500 

This program is testing for two different conditions. Both events are detected by 
filters. 
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PROGRAM 3: 

Store: all frames Block 6: 
nonstop 

Block 1 : 

Start timer DURATION 
and then 

Start frame counter TOT FRAME 

Block 2: 
When timer DURATION exceeds 60 seconds then go to block 6 
else when frame matches TYPE_06_00 

and LENGTH_500 then go to block 3 
else when frame matches TYPE_06_00 then go to block 4 
else when frame matches LENGTH_SOO then go to block 5 

Block 3: 
Increment counter CT_TYPE 
and then 

Increment counter CT LENGTH 
and then 

Mark Frame 
and then 

Go to Block 2 

Block 4: 
Increment counter CT_TYPE 
and then 

Mark frame 
and then 

Go to block 2 

Block 5: 

Increment counter CT_LENGTH 
and then 

Mark frame 
and then 

Go to block 2 
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and then 

Start display 
and then 

Stop test 



PROGRAM EXAMPLE 4. 

REQUIREMENT: 

CONDITIONS: 

You want to know the length of frames that are occurring on 
the network. You need to know how frames are distributed 
within several ranges of frame length. 

The ranges you wish to use are: 

51- 100 bytes 
101- 500 bytes 
501- 2022 bytes 

You need to define the following items: 

A timer named DURATION 

A frame counter named TOT FRAME 

A counter named 51_100 
A counter named 101-500 
A counter named 501 2022 

A filter named FILTER 51 100 
A filter named FILTER 101 500 
A filter named FILTER_501_2022 

The filters will look for frame lengths within certain ranges. As each filter is matched, 
a corresponding counter will be incremented. 

<Edit Programs> Menu 14-60 



PROGRAM 4: 

Store: all frames 
nonstop 

Block 1: 
Start frame counter TOT_FRAME 

and then 
Start timer DURATION 

Block 2: 
When timer DURATION exceeds 30 seconds then go to block 6 
else when frame matches FILTER_51_100 then go to block 3 
else when frame matches FILTER_101_500 then go to block 4 
else when frame matches FILTER_501_2022 then go to block 5 

Block 3: 
Increment counter 51_100 

and then 
Go to block 2 

Block 4: 
Increment counter 101_500 

and then 
Go to block 2 

Block 5: 
Increment counter 501·2022 

and then 
Go to block 2 

Block 6: 
Stop timer DURATION 

and then 
Start display 

and then 
Stop test 
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15 
< 1/0 FUNCTIONS > MENU 

This section describes the <1/0 Functions> softkey control of the HP 497 lS LAN 
Protocol Analyzer in master/slave (remote/local) applications. 

This section includes: 

• <1/0 Functions> Softkey Selections 

• Introduction 

• Editing The 1/0 Configuration 

• Saving the 1/0 Configuration 

• Capturing A Slave LAN Protocol Analyzer 

• Editing And Sending A Modem String 

• Enabling 1/0 Operation 

• 1/0 Status Messages 

• <Terminal Emulator> Description 
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< 1/0 Functions > Softkey Selections 

<I/0 Functions> 

Edit Config. 

Save Conf ig. 

Capture Slave 

Edit Modem Str 

Send Modem Str 

Enable I/0 

OTHER CHOICES 

Send At Power On 

ASCII 7 

ASCII 8 Roman 8 

EBCDIC 

EXIT 

Terminal Emulator 

Local Echo 

Auto Linefeed 

Show Non-printing 

ASCII 7 ASCII 8 Roman 8 

EXIT 
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Introduction 

The master/slave feature lets you view the operation of a Local Area Network (LAN) 
or LAN segment from a site not directly adjacent to the LAN. For example, you could 
view all the LANs in your company from one remote location. 

Performing HP 497 lS logic analyzer operations on a LAN from a remote location 
requires two HP 497 lS instruments. 

Primary capabilities or features offered by using two HP 4971S's in master/slave 
operation are: 

Testing a LAN from a remote location. 
Selecting a printer located at the master or slave location. 
Selecting a mass storage located at the master or slave location. 

Your two HP 497 lS systems must be connected by an RS-232C link. Option 002 
provides a RS-232C Remote Communications Interface package which includes an 
interface board and cables. Each station requires an Opt. 002 to be installed in the 
497 lA instrument. 

In remote operation, the master protocol analyzer shows the same screen display that 
the slave protocol analyzer would display if it were under local control. 

The keyboard of the master unit is the controlling keyboard. Local keyboard control 
may be regained at either the master or .slave location by pressing the BREAK key on 
the keyboard. The BREAK key disconnects the RS-232 link and returns both units to 
local operation. 

When an HP 497 lS is linked for remote operation it communicates with another station 
with the protocol, DDCMP. This protocol allows stations to send and receive data or 
command information with the protocol handling the problems of framing, error 
control, sequence control, and message transparency. 

The protocol makes sure that one station is ready to receive information and another 
station is ready to transmit information at the right time. The protocol automatically 
handles retransmission in case of errors. 
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The I/O Configuration table shown below is stored on the LANSYS volume. The menu 
shown below is displayed when you press the <1/0 Functions> <Edit Config.> softkeys. 

1 

2 
3 RS-323 Configuration 
4 

5 

6 

7 
8 
9 

10 
11 
12 
13 
14 

15 

16 
17 

18 
19 

20 
21 

22 
23 

Baud Rate: 1200 
Stop Bits: .! 
Parity Bit: None 
Bits/character: 8 
Hardware handshake: Disabled 
Software handshake: Disabled 

Remote protocol: DDCMP 

DDCMP timeout: ~ seconds 
DDCMP buffer size: 2..1.f bytes 

300 600 1200 2400 

(Defaulted by protocol selection) 
(Defaulted by protocol selection) 

(Defaulted by protocol selection) 

4800 9600 EXIT 

24'----------------------------------------------------------------......1 

Figure 15-1. <1/0 Functions> Configuration Display. 
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Editing The 1/0 Configuration 

Communication between the master and the slave protocol analyzers occurs over an 
RS-232 link. 

At power on, the protocol analyzer automatically loads your configuration. The 
power-on configuration can be changed by using <Edit Config.> to define a new 
configuration and then usmg <Save Config> to rewrite the configuration to the disc 
volume currently selected in <Disc Functions> Menu. 

<Edit Config.> 

Baud rate: 

softkey lets you edit the HP 497 lS l/O configuration table to 
meet your system configuration. 

The fields that can be changed are shown in inverse video. To 
change a field, use the TAB key or the cursor keys to move 
the cursor to the field you want changed. 

When the cursor is placed in a highlighted field, the softkey 
choices for that field are displayed. Press the softkey for the 
choice you want. The menu field is changed immediately. 

This line displays the selected transmission rate. 

This line is used to select how fast the transmission occurs on 
the RS-232 link between the protocol analyzers. 

The default transmission rate is 1200. To select a different 
baud rate, move the cursor to the "Baud Rate:" field. Press one 
of the displayed softkeys to choose a new transmission speed. 
The choices are: 

300, 600, 1200, 2400, 4800, 9600 



Stop bits: 

Parity bit: 

This line shows the selection for stop bits. 

Stop bits are supplied after each transmitted character as part 
of the system for maintaining synchronization between 
transmitting and receiving stations. 

The default stop bit length is l. 

To choose a different stop bit length. move the cursor to the 
"Stop Bits:" field. Press one of the displayed softkeys to choose 
a new stop bit length. The choices are: 

1, 1.5, 2 

This field may be edited only when Encoded DDCMP 
protocol has been selected. 

The "Parity Bit:" field lets you choose what parity format is 
used with each transmitted character. The HP 497 IS transmits 
the parity bit(s) with each character for error checking by 
other computer systems. The HP 497 IS does not use the parity 
bit(s) itself; it uses CRC error checking. 

In standard DDCMP, the parity bit is not selectable and the 
default state is None 

In Encoded DDCMP, the parity bit is used and the default 
selection i~ Odd. To choose a different parity bit condition, 
move the cursor to the "Parity bit:" field. Press a displayed 
softkey to choose a new parity bit format. The choices are: 

None Odd Even 
Parity Parity 
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Bits/character: 

Hardware handshake: 

DISABLED 

This field enables the RS-232 link to group the transmission in 
character lengths of 7 bits or 8 bits. 

Bits/character field can be edited only when Encoded 
DDCMP is selected. 

In DDCMP mode, the default Bits/character selection is 8. 

Encoded DDCMP mode lets you choose bits/character. To 
choose a different character length, move the cursor to the 
"Bits/character:" field. Press a displayed softkey to choose a 
new character bit length. The choices are: 

7 8 
Bits/char Bits/char 

This field lets you choose how your modem handles messages 
between the modem and the protocol analyzer. Hardware 
hand shaking involves the control lines between the protocol 
analyzer and the modem such as: Request To Send (CTS), Clear 
To Send (CTS), and Carrier Detect (CD). 

To choose a different hand shaking method, move the cursor 
to the "Hardware Handshake:" field. Press a displayed softkey 
selection to enable the new hand shake function. The softkey 
choices a re: 

Disabled Modem Modem 
____ Hf-Duplex Fl·Duplex 

Hand shaking can be disabled when two HP 497 lS protocol 
analyzers are hard wired together. In this application, modems 
are not used and hand shaking is not required. 

Select the hand shaking required for the modems used in your 
system. 
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MODEM HF-DUPLEX 
hand shaking is selected when either modem transmits or 
receives but not both directions simultaneously. 

MODEM FL-DUPLEX 

Software Handshake: 

hand shaking is selected when either modem transmits or 
receives simultaneously in both directions. 

This field lets you choose different methods of hand shaking 
between protocol analyzers and other computers to control 
message flow. 

Software hand shaking may be selected only in the Encoded 
DDCMP mode. With standard DDCMP, only hardware hand 
shaking may be used. 

Some systems using Encoded DDCMP may use a combination 
of hardware and software hand shaking. 

To choose a software hand shaking function, move the cursor 
to the Software Handshake Field. Press a displayed softkey to 
choose the mode you want. The choices are: 

Disabled ENQ/ACK ENQ/ACK DC1/DC3 DC1/DC3 DC1/DC3 
Host Terminal Host Terminal Both ---- ----
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Remote protocol: 

DDCMP 

field shows your selection for the RS-232 link protocol. 

To choose a different protocol, move the cursor to the 
Protocol Field. Press one of the displayed softkeys to choose a 
new protocol. The choices are: 

DDCMP Encoded 
DDCMP 

DDCMP is the default choice. 

DDCMP is a byte count oriented protocol that breaks its 
messages into two parts: a header containing control 
information and a text body that contains the data portion of 
the message. 

Encoded DDCMP 
Encoded DDCMP groups the DDCMP frames of the protocol 
analyzer communications into printable ASCII characters. This 
allows characters in the protocol analyzer's communications to 
pass through data communication equipment or a host 
computer with none of the characters recognized as control, 
transparent, or escape characters. 

Figures 15-2 and 15-3 show the differences in the configuration fields that may be 
selected between DDCMP and Encoded DDCMP. 
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DDCMP timeout: 

DDCMP Buffer Size: 

field lets you select how long the protocol analyzers wait for 
responses to queries or commands. If the response does not 
come in the required time, the protocol analyzer goes to its 
next decision point to decide what action to take. 

The default timeout is 3 seconds. 

The timeout period may be selected from softkeys by moving 
the cursor to the protocol time out field and pressing one of 
the displayed softkeys: 

2 3 10 30 60 
Seconds Seconds Seconds Seconds Seconds Seconds 

When using two HP 497 lAs in half duplex, it may be helpful 
to enter different times for the timeout. In half duplex, if a 
fault occurs and both units back off, they may wait the same 
time and then try to establish contact again at the same time. 
It may be better to have the master station slightly faster than 
the slave station. 

field lets you vary the size of the messages being sent between 
stations. 

If you are sending messages to some station other than an HP 
497 lS, the receiving station's buffer may not be able to receive 
512 bytes at a time. If longer message lengths are transmitted 
than the recetver can handle, a buffer overrun may occur. 

The default choice for buff er size is 512 bytes. Softkey 
choices for buffer size are: 

32 
Bytes 

64 

Bytes 
80 

Bytes 
128 

Bytes 
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RS-232 Configuration: 

Baud rate: 
Stop bits 
Parity bits: 
Bits/character: 
Hardware handshake: 

1200 
1 
None 
8 
Disabled 

* 
* 

SOFTK EY CHOfCES 

300, 600, 1200, 2400, 4800, 9600 

.!. 1.5, 2 

DISABLED, Modem Hf ·Duplex, 
Modem Fl-Duplex 

Software Handshake: Disabled * 

Remote protocol: DDCMP 

Protocol timeout: 
DDCMP buffer size: 

3 seconds 
lli bytes 

1, 2, ~. 10, 30, 60 
32, 64, 80, 128, 256, 2..1.f 

* (Defaulted by protocol selection.) 
IO: 

Figure 15-2. Configuration Choices With DDCMP Selected. 
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RS-232 Configuration: 

Baud rate: 
Stop bits 

1200 
1 

Parity bits: None 
Bits/character: 8 
Hardware handshake: Disabled 

Software Handshake: Disabled 

Remote protocol: DDCMP 

Protocol timeout: 3 seconds 
DDCMP buffer size: 512 bytes 

SOFTKEY CHOICES 

300, 600, 1200, 2400, 4800, 9600 
_l, 1.5, 2 
None, Odd Parity, Even Parity 
7 bits/char, 8 Bits/char 
DISABLED, Modem Hf-Duplex, 
Modem Fl-Duplex 
Disabled, ENQ/ACK Host, 
ENQ/ACK Terminal, DC1/DC3 Host, 
DC1/DC3 Terminal, DC1/DC3 Both 

1, 2, ~. 10, 30, 60 
32, 64, 80, 128, 256, 512 

IO: 

Figure 15-3. Configuration Choices With Encoded DDCMP Selected. 
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<Save Config.> 

Saving The 1/0 Configuration 

softkey saves a copy of the configuration table to the 
Configuration File, CNFG. 

The Configuration file is located on the LA NCOD system disc. 
When you save the configuration, the protocol analyzer looks 
for the LANCOD volume. The analyzer prompts you to 
install LANCOD if it is not found. 

In systems using only the HP 9122D Dual disc Drive, you must 
install the LANCOD disc in a disc drive slot. In systems with 
system software loaded on a Winchester disc drive, the 
analyzer will find LANCOD on one of the hard disc volumes. 

If two LANCOD volumes are found in the system, the 
protocol analyzer saves the Configuration File, CN FG, to the 
lowest volume unit number. 
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Capturing A Slave LAN Protocol Analyzer 

<Capture Slave> softkey starts the process of combining two HP 497 lS systems 
into a master/slave operation. The protocol analyzer where 
you press <Capture Stave> softkey becomes the master or 
controlling device. The other HP 497 lS then becomes the 
slave or measuring device. 

After the <Capture Slave> soft.key is pressed, the master 
analyzer displays: 

To terminate Master · Slave mode, hit the "BREAK" key. 

Waiting for permission to take control. IO: 

The master analyzer then establishes contact with the slave. 
After contact is established, the slave displays the message: 

A request to take over control has been received 
over the I/O. Do you wish to relinquish control? 
If you do not respond in 10 seconds, control will 
be given to the requesting device. 

Al low 
Takeover 

Block 
Takeover 

If you do not want to loose control at the slave unit, you must 
press the <Block Takeover> sof tkey within 10 seconds. If you 
do not, the slave defers control to the master device. 

After the master captures control of the slave protocol 
analyzer, the master displays the Top Level Menu and the 
message: 

You are now controlling the remote analyzer. IO: 

(continued) 
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<Capture Slave> 
(cont.) 

Also after capture, the slave displays the message: 

This instrument is being remotely controlled. 
Hit 11 BREAK 11 key and wait to rea::iin control. 

If no RS-232 link up occurs, the master cannot capture control 
of the slave protocol analyzer and the master displays: 

SLAVE IS NOT RESPONDING 

Troubleshooting <Capture Slave> softkey 

If the master HP 497 lS is not able to capture control of the slave HP 497 lS, several 
steps are listed below that may help you resolve the problem. 

I. Press <1/0 Functions> softkey at each device. 

Verify the configuration table is the same for each device. 

2. Verify <Enable l/0*> soft.key is active at each protocol analyzer. 

* is displayed in the <Enable I/0> soft.key when it is enabled. 

If an IO message is displayed in the lower right corner of the screen, see the 10 
STATUS tables in this section for how to read the status message. 

3. Verify the connections from the protocol analyzers to each modem. 
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Editing And Sending A Modem String 

<Edit Modem Str> softkey may be used with modems whose functions can be 
programmed via a message string from the device the modem 
supports. 

The modem string can consist of up to 80 characters. When 
you perform a <Save Config.> operation, you also save the 
modem string. In default mode, a modem string is not defined. 
If you want to define a modem string, press <Edit Modem Str> 
soft key. 

If the string needs a return character. use CONTROL M or 
press RETURN key to enter a return character. 

Modem Substrings 

/2+++ 

/2ATzcR 

/lATD404cR 

The modem string can be divided into segments with a user 
defined amount of delay between sending each segment. 

The character sequence "/N" (N = 0 .. 9) can be used to divide 
the modem string. If "/N" is used, characters to the left of the 
"/N" will be sent first followed by a delay of "N" seconds, then 
followed by the characters to the right of the "/N". More than 
one "/N" may appear in the Modem String. 

Example: 12+++/2ATzc R/1ATD404c R 

After the string is enabled to be sent, the analyzer waits 2 
seconds and sends" +++ ". 

The analyzer waits 2 seconds and sends 
carriage return. 

" ATZ " and a 

The analyzer waits 1 second and sends " ATD404 " and a 
carriage return. 

The sequence "//" or a single "/" foil owed by any character 
other than "0 .. 9" is treated as a "/" character in an undivided 
string. 
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<Send At Power On> 

<ASCII 7> 

softkey lets the message automatically be sent to your modem 
each time the power switch is cycled on. To do this, you must 
first define a string, enable the <Send At Power On> softkey, 
and then use <Save Config.> softkey to save the modem string 
in the configuration file. 

You must save the configuration file before you turn power 
off or it is lost. 

<Send At Power On> acts as a toggle switch. When the 
softkey is active, an asterisk (*) is displayed in the softkey field 
and the modem string is sent at power on. Press the softkey 
again; the asterisk is removed from the softkey field and the 
modem string is not sent at power on. 

<ASCII 8 Roman 8> 
<EBCDIC> 

<Send Modem Str> 

These softkeys let you choose the character code used in the 
modem string. Choose the character code required by your 
modem. 

Other character codes are displayed if optional keyboards are 
used. See Appendix B. 

softkey manual1y sends a modem string without having to 
cycle the protocol analyzer power. Check that you have 
created the string you want and then press <Send Modem Str> 
softkey. 

The <Enable 1/0> softkey must be off in order to send the 
modem string. 
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EXAMPLE FOR USING HP 4971 S WITH HP "SUPPORT LINK" MODEM 

PROCEDURE 

1. Set the HP 497 lS Configuration Menu parameters as follows: 
Baud Rate: 1200 
Stop Bits: l 
Parity Bit: None 
Bits/Char: 8 
Hardware Handshake: Full Duplex; modem connection 
Software handshake: Disabled 

2. Use the following modem strings: (ASCII 7-bit or 8-bit data code). 

Caller: 
<CTRL·E>CR/10CR/11CR/13CR/1CR/1DCR/1<number>CR/1CR/1 

L letter '0' 

Unit to be called: 

<CTRL-E> = 
c 

R 
<number> 

= 
= 

'CTRL' key plus ·letter 'E' key. 
RETURN key 
Telephone number (l or more digits) 

3. Before pressing the <Save Config.> softkey to save the configuration, check that 
the following softkeys are enabled: 

<Send At Power On*> 
<1/0 Ena bled*> 
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EXAMPLE FOR USING THE HP 4971 S WITH THE HA YES "Smartmodem 1200" 

PROCEDURE 

1. Set the configuration switches for the Hayes "Smartmodem 1200" as follows: 
(Switches are behind the front panel.) 

Sl 
S2 
S3 
S4 

Down 
Up 
Down 
Up 

SS 
S6 
S7 
SS 

Up 
Up 
Up 
Down 

2. Set the HP 497 lS configuration menu parameters as follows: 

Baud Rate: 
Stop bits: 
Parity Bit: 
Bits/Char: 
Hardware Handshake: 
Software Handshake: 

1200 
I 
None 
8 
Full duplex; modem connection 
Disabled 

3. Use the following modem strings: 

Caller: 

Unit to be called: 

c 
R 

<number> 
= RETURN key 
= telephone number ( l or more digits) 

4. Before pressing the <Save Config.> softkey to save the configuration, check that 
the following softkeys are enabled: 

<Send At Power On*> 
<1/0 Enabled*> 
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<Enable 1/0> 

Enabling 1/0 Operation 

soft key enables the HP 4971 S LAN Protocol Analyzer to 
communicate with another HP 497 lS. 

The <Enable 1/0*> softkey must be off in order to <Send 
Modem Str*> manually or to <Edit Config>. 

<Enable 1/0> acts as a toggle switch. An asterisk (*) is 
displayed when the function is on. Press the softkey again to 
remove the(*) and disable the function. 

Status Messages 
<Enable 1/0*> softkey also enables a status message field to 
help you know what activity is occurring on the master/slave 
link. 

This status field is located at the lower right corner of the 
display, just above the <EXIT> softkey. 

IO status messages are discussed on the following pages. 
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1/0 Status Messages 

The HP 497 lS shows I/0 status messages at the lower right corner of the display, just 
above the <EXIT> softkey. 

Each protocol analyzer displays what i! is doing or seeing. For example, if Station is 
transmitting a message to Station 2, the display on each terminal would be: 

Station 

IO: __ t __ : __ _ 

This unit is transferring a 
frame to the RS-232 card's 
buff er. 

Station 2 

IO: ____ :_r __ 

This unit is receiving a 
frame. 
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1/0 status messages can be grouped in the foJiowing functions: 

NORMAL STATUS 

This group of status characters reports the normal operation of your 
master/slave systems in remote operation. 

PERSISTENT ERRORS 

This group of status words and characters reports persistent problems that 
are occurring. 

MODEM NOT READY ERRORS 

The modem attached to your protocol analyzer is not ready for establishing 
communications between the stations. 

RUN TIME ERRORS 

This group of error messages reports hardware failures. 
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NORMAL STATUS 

The two following tables describe status characters that may be displayed in the 
Normal Status fields. These fields report the activity of your systems remote 
communications. 

1/0: ____ _ 

I 
Protocol State __ I 
Transmit Information_! 

Transmit Information Field 

CHARACTER(S) 
DISPLAYED 

PROTOCOL STATE 

!~~Receive Information 

DESCRIPTION 

A This unit is attempting to acknowledge the start of 
communication by other unit. 

H This unit is halted. 

This unit is attempting to start communication with other unit. 

FRAME TRANSMISSION INFORMATION 
B Other unit has received a good data frame but was unable to 

accept it because there was no message buffer available. 

C Other unit has received a frame with an FCS error. 

O Other unit has had a receiver overrun error. 

t This unit is transferring a frame to the RS-232 card's buffer. 

w This unit is constructing one or more data frames for 
transmission of a message. 
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NORMAL STATUS (cont.) 

I/0: ____ _ 

Protocol State __ ! 
Transmit Information_! 

! __ Receive Information 

Receive Information Field 

CHARACTER(S) 
DISPLAYED 

B This unit has 

DESCRIPTION 

received a good data frame but was unable 
accept it because there was no message buffer available. 

c This unit has received a· frame with an FCS error. 

0 This unit has had a receiver overrun error. 

p This unit is processing a received message. 

r This unit is receiving a frame. 
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PERSISTENT ERRORS 

lf persistent errors occur on the 1/0 interface, each protocol analyzer displays, in 
inverse video, one of the following messages. 

Persistent error messages are displayed in the following groups: 

START 

START ACK 

ACK 

RCV 

IO:START 

I 
Pershtent Error_! 

10: START 

10: START ACK 

This unit is having difficulty starting communication. 

This unit is having difficulty acknowledging the start of 
communication. 
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10: ACK 

PERSISTENT ERRORS (cont.) 

This unit is having difficulty sending a frame to the 
other unit. 

! __ Status Character( s) 

CHARACTER(S) 
DlSPLAYED DESCRIPTION 

B Other unit received a good data frame one or more ti mes but was 
unable to accept it because there was no message buffer available. 

D Other unit received one or more frames with an FCS error in the 
Data Field. 

F Other unit has r_ecei ved one or more frame headers with a format 
error. 

H Other unit received one or more frame headers with an FCS error. 

L Other unit has received one or more data frames that are too long. 

O Other unit has had one or more receiver overrun errors. 

T Other unit has failed to respond for some period of time. 
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10: RCV 

PERSISTENT ERRORS (cont.) 

This unit is having difficulty receiving a frame from the 
other unit. 

'~~-Status Character(s) 

CHARACTER(S) 
DISPLAYED DESCRIPTION 

B This unit received a good data frame one or more ti mes but was 
unable to accept it because there was no message buffer available. 

D This unit received one or more frames with an FCS error in the 
data field. 

This unit has received one or more frame headers with a format 
error. 

H This unit received one or more frame headers with an FCS error. 

L This unit has received one or more data frames that are too long. 

O This unit has had one or more receiver overrun errors. 
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MODEM NOT READY ERRORS 

MODEM NOT READY The modem at the station displaying this message is not 
ready. Possible causes are listed below: 

HALF DUPLEX MODE 
Data Set Ready line is false. 

FULL DUPLEX MODE 
Data Set Ready or Carrier Detect lines are false. 
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RUN TIME ERRORS 

IO: Error 

I I 
_ I I __ 

11 ESCAPECODE 11 FIELD 11 IOE RESULT" or 11 IORESULT 11 FI ELD 

Example: 

IO: Error -12 CPU bus error. 

-26 12 No driver for this card. 

-26 17 A time out has occurred. 

-26 19 Bad status or control. 

-26 21 Interface card is not operating. 

-26 306 Datacomm interface failure. 

If other Run Time Errors occur, contact your HP Response Center. 
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< Terminal Emulator > Description 

The <Terminal Emulator> softkey provides access to configuration menus of 
intelligent modems. It lets you interactively configure modem parameters. 

Using convenient keyboard entry, you can send and receive on a character basis to 
the modem. The terminal transmits each character as it is typed. Modem responses 
are shown on the terminal display. 

Using the HP 497 lS in terminal emulator mode requires detailed knowledge about 
your modem's operation. Refer to your modem's manual for guidelines to follow 
when sending commands to the modem and decoding modem responses. 

Configuring The Terminal 

Use the <1/0 Functions> <Edit Config.> softkeys to configure the terminal to be 
compatible with your modem. The 1/0 configuration menu is described earlier in 
this chapter. 

Choosing Terminal Functions 

<Local Echo> 

<Auto Linefeed> 

causes each key selection to be shown on the display. 

When the receiving modem does not provide echo printing 
back to the display, this softkey lets you see your entry as 
you type each character. 

If you select <Local Echo> and the receiving modem also 
provides echo printing, double characters are displayed. 

causes the terminal to automatically send a line feed 
character to the display after a carriage return character is 
sent to the display. 
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<Show 
Non-printing> 

<ASCII 7> 
<ASCII 8 Roman 8> 
<EBCDIC> 

shows non-printing characters on the display. 
Characters are displayed if they are entered from the 
keyboard or received from the modem. 

For example: in ASCII-7 character code. pressing the keys, 
CTRL and D, displays the character ET only when <Show 
Non-printing> softkey is enabled. 

softkeys let you select the character code set for the 
displayed and transmitted characters. 

Optional keyboards let other character codes be displayed. 
See appendix B for keyboard and character code 
descriptions. 

<1/0 Functions> Menu 15-30 



16 
<Execute Program> MENU 

This chapter describes the softkeys used for the <Execute Program> Menu. 

From this menu, you select the source of frames for the program you want to execute. 
The frames may be already stored in the Receive Buff er, or, the source may be frames 
that are occurring on your Local Area Network. 

In addition, this menu allows access to the <Edit Programs> Menu and to the <Examine 
Data> Menu. 

This chapter includes: 

• <Execute Program> Softkey Selection 

• <Execute Program> Operation Considerations 

• Running Programs From The Network 

• Running Programs From The Buff er 

• Examine Data After Program Run 

• Edit Functions In <Execute Program> Menu 

• <Execute Program> Soft LED Indicators 

16-1 



< Execute Program > Softkey Selections 

Execute Program 

Run From Network 

Run From Buffer 

Edit Program 

Examine Data 

EXIT 

Run which program? 
Program·O 
Program· 1 
Program·: 
Program-5 
EXIT 

Run which progr.am from buffer? -----­
Program· 0 
Program· 1 

Program·: 
Program-5 
EXIT 

Edit which program? 
Program·O 
Program· 1 
Program·: 
Program-5 
Edit New Program 
Rename Program 
OTHER CHOICES 
Delete Program 
EXIT 

(See <Examine data> Menu section) 
EXIT 
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< Execute Program > Operating Considerations 

See the appendix section for a list of program execution times. The following 
paragraphs give general considerations for program execution. 

Frame Acquisition Versus Display Speed. 
The protocol analyzer operating software performs two functions. First, it must look 
for frames matching filter conditions and store all qualified frames in the Receive 
Buff er. Second, it must run the <Edit Program> routines that you have programmed. 

The task of looking at all frames for filter matches and then storing the selected frames 
in the Receive Buff er is happening in realtime at 10 Mbits/sec. The frames can not be 
displayed in real time. As the display is updated, the last frame stored in the receive 
buffer is displayed next. 

At the same time the protocol analyzer is storing frames in realtime, your <Edit 
Program> softkey program is also being executed. Routines such as updating the 
display, controlling the counters and timers, and beeping are performed relatively 
slowly compared to the· realtime data acquisition rate. 

In any circular mode of memory storage ( Nonstop, Centered About, and Ending 
With }, if the Receive Buff er is filled before the display, counter, timer, and beeper 
routines are completed, the protocol analyzer cannot begin writing new frames over the 
oldest frames previously stored in memory. 

If network traffic loading is heavy, the program may cause the protocol analyzer to 
stop acquiring frames and display a message stating that a buffer overflow has 
occurred. 

Recommendation 
In order to reduce processor time spent displaying frames, counters, timers, and 
controlling the beeper, try to minimize using these programmable functions while 
storing frames. 

An alternative is to capture the frames first, without displaying information, and then 
run your program in <Run From Buffer> mode. 

In <Run From Buffer> mode, no conflict occurs between storing frames and displaying 
information since the frames are already captured. 



Running Programs From The Network 

NOTE 

If you have not created a program, the protocol analyzer 
goes to a default PROGRAM_O. This program contains the 
default "Store" command: 

Store: all frames 
until buffer full 

This lets the protocol analyzer monitor the network or 
Receive Buffer in the absence of a user created program in 
<Run From Network> or <Run From Buffer> modes. 

<Run From 
Network> 

causes the protocol analyzer to execute a selected program 
using frames presently occurring on the Local Area Network. 

Press the <Run From Network> softkey to display: 

Run which program? _ 

Press the softkey whose label contains the program you wish 
to execute. The sof tkey ca uses the program to begin executing 
immediately. 

If only 1 program is defined, it is run automatically without 
going through the "Run which program?" question. 

Up to five programs can be created and displayed as softkey 
selections. 
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Running Programs From The Buffer 

<Run From Buffer> causes the protocol analyzer to execute a selected program 
using data previously stored in the Receive Buff er or in 
log-data disc files. 

Choose the data source. 

RECEIVE BUFFER 
To execute a program from the Receive Buffer, load the 
buff er with frames directly from the network. 

LOG-DAT A DISC FILE 
To execute a. program from a log-data file, use the <Disc 
Functions> Menu to load a log-data file to the Receive Buffer. 
The analyzer then automatically uses the log-data file as the 
frame source while executing the program. 

Choose the program to execute. 

Press the <Run From Buffer> softkey to display: 

Run Which Program From Buffer? 

Press the softkey whose label contains the program you wish 
to execute. The softkey causes the program to immediately 
begin execution. 

If only one program is defined, it is run automatically without 
going through the "Run which program?" question. 

Up to five programs can be created and displayed as softkey 
selections. 
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Run from Receive Buffer. 

When the Receive Buff er is the source of frames used for 
executing a program, the "Store" command shown in the top 
line of your program display is ignored in <Run From Buffer> 
operation since the frames you are using are already stored in 
the Receive Buffer. 

The frames in the receive buffer are not changed .by executing 
the program. 

<Execute Program> updates the "Filters" field to show what 
filters are matched in each frame. Trigger events specified by 
the program's "Store:" statement are updated. Trigger events 
are frames that match the statements: Starting With, Centered 
About and Ending With. 

Executing <Run From Buff er> automatically clears the "Mark 
Frame" condition from frames in the Receive Buffer. Timers 
and counters are reset. The timestamp for when each frame 
occurred on the network is retained. 

Run from Log-data disc file. 

If the Receive Buffer has been filled from a log-data file, the 
<Run From Buffer> command executes using frames in the 
log-data disc file. 

Only frames from the log-data file that match the selected 
program's "Store:" command, filters and trigger events are 
written to the Receive Buffer or output file. The original 
timestamp for when each frame occurred on the network is 
kept. 

The contents of the log-data file on the disc are not disturbed. 
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Examine Data After Program Run 

After a program run is completed, the protocol analyzer automatically goes to 
<Examine Data> Menu. The list below shows what information is displayed. 

Program Data Source 

Run from Network 

Run from Network 

Run from Buff er 
(Buffer filled 

from network) 

Run from Buff er 
(Buffer filled 

from network) 

Run from Buffer 
(Buffer filled from 

log-data file) 

Run from Buff er 
(Buffer filled from 

log-data file) 

"Log File:" 
command used? 

NO 

YES 

NO 

YES 

NO 

YES 

<Examine Data> Display 

Receive Buffer data 

Log·data file on disc 

Receive Buffer data 

Receive Buffer data 

Original log·data file on disc 

New log-data file on disc 

To fill the Receive Buff er from a log-data file, use <Disc Functions> <Load File> menu 
and select a log-data file existing on the selected volume. 
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Edit Functions In <Execute Programs> Menu 

<Edit Program> 

<Examine Data> 

softkey provides a convenient branch to the <Edit Programs> 
Menu. 

You can choose to edit the following programming functions: 

<Edit New Programs> 

<Rename Programs> 

<Delete Program> 

Detailed descriptions of these softkey functions are given in 
the <Edit ProgramS> Softkey Descriptions section in Chapter 
14. 

When you branch to the <Edit Programs> Menu and finish 
editing a program. press the <EXIT> softkey to return to the 
<Execute Program> Menu. 

softkey lets you view data stored in the Receive Buffer. 

See the <Examine Data> Menu section for a description of the 
softkeys available. 

When you press the <Examine Data> softkey, the protocol 
analyzer branches to the <Examine Data> Menu. All the 
normal <Examine Data> Menu softkeys are available for you 
to view the frames. However, when you press the <EXIT> 
softkey in <Examine Data> mode, you return to this <Execute 
Program> Menu. 
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< Execute Program > Soft LED Indicators 

In <Execute Program> operation, characters are provided to indicate the following 
activities: 

The protocol analyzer is transmitting a frame. 

The protocol analyzer has detected a collision. 

The protocol analyzer is receiving a frame. 

These activities are indicated by the characters shown below the softkeys at the lower 
right corner of the display. 

T 'C R 

Each character is displayed in normal video when there is no activity, that is, the 
function is "Off". Characters are displayed inverse video when their function is active 
or "On". 

T 

c 

R 

indicates the protocol analyzer is transmitting on the network. 

indicates colilsions are occurring on the network. Hardware for 
the collision counter detection circuit has detected a collision. 

indicates the protocol analyzer is receiving a frame. This soft 
LED turns on when a frame passes through the Runt frame 
filter. 
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WHEN ARE THE SOFT LEDs DISPLA YEO? 

The soft LEDs are displayed during the following program execution: 

1. When a <Run From Network> program specifies any "Store:" operation that 
stores frames in the Receive Buffer. 

2. Only the "T" soft LED appears when a <Run From Network> program 
specifies storing no frames and also specifies sending messages. 

The "T" does not appear until the first message is sent in this program's 
execution . 

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDs? 

Short display 

Long Display 

Since the frames on a LAN are being transmitted at 10 
Mbits/sec, there are times when the soft LEDs will be on too 
briefly to notice. 

This is most likely to happen when the network traffic load is 
very light. 

In contrast, there are times when the soft LEDs will be on 
longer than the duration of an event. 

For the Collision and Receive soft LEDs, the "On" duration 
can be from five milliseconds to one second. The time 
depends on the amount of traffic on the network and the 
contents of the program for the Collision and Receive soft 
LEDs. 

For the Transmit soft LED, the duration depends on the 
length of the message to be transmitted, the frequency of 
transmission, and how often other traffic on the network 
permits the frame to be transmitted. 
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WHAT DISTORTS THE SOFT LEDs DISPLAY? 

Transmit 

Collision 
Receive 

Because frames are transmitted at 10 Mbits/sec, the duration 
of frames is very short. This soft LED appears to not be on if 
your program uses "Store: no frames" and short frames are 
sent in small groupings. 

These two soft LEDs do not display in real time. When a 
collision or received frame happens, the soft LED indication 
occurs some time later. 

This time lag can vary from one millisecond to one second. 
Maximum time lag occurs when: 

The network is lightly loaded 
(less than 64 frames/second) 

AND 

A <When> statement is not being executed ,in the program. 
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17 
<Monitor Network> MENU 

This chapter describes the softkeys used to monitor network message traffic. 

<Monitor Network> softkey lets you quickly begin looking at frames on your Local 
Area Network with only a few simple softkey selections. 

This chapter includes: 

• <Monitor Network> Softkey Selections. 

• <Monitor Network> Softkey Descriptions. 

• <Monitor Network> Soft LED Indicators 

• <Monitor Network> Anomalies 
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< Monitor Network > Softkey Selections 

Monitor Network ... _ ....... _ ... _ ............................................................. . 
Nonstop Mode 

Until Full 

Start Monitor 

Stop Display/Start Display 

Stop Monitor 
(Examine Data selections) A 

Next Frame 

I 

EXIr 
I 

Continue Monitor 

Select Format B 

EXIT (to Monitor Notwork Menu) 

Examine Data A (see Examine Data Selections) 

EXIT (to Top Level Menu) 
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A, B Functions from <Examine Data> Menu 
See <Examine Data> Menu section for details. 

A Examine Data 
Next Frame 

2 Previous Frame 
3 Scroll Frames 
4 Go To Frame # 

5 Timers & Counters 
B 6 Select Format 

7 Other Choices 
8 Next Marked 

Detailed Format 
Summary Format 
Filter Format 
Change Headers 
Change Dataf ield 
Change Timestamps 
EXIT 

9 Previous Marked 
10 Scroll Marked 
11 Mark/Unmark 
12 Show Node Names 
13 Show Hex Addresses 
14 EXIT 



< Monitor Network > Softkey Descriptions 

<Monitor Network> provides an easy-to-use method for capturing and viewing network 
messages with the protocol analyzer. 

In <Monitor Network> mode, you capture all messages appearing on a local area 
network. The messages are captured exactly as they appear on the network. The 
display updates with the most recently stored frame in the Receive Buffer. Monitoring 
is done in a transparent or unobtrusive mode with the protocol analyzer generating no 
signals back to the network. 

<Monitor Network> 

<Nonstop Mode> 

<Until Full> 

uses the Store command: Store: all frames 

to capture frames occurring on the Local Area Network. 
Softkeys <Nonstop Mode> or <Until Full> mode determine 
how the protocol analyzer fills ifs Receive Buffer. 

causes the receive buffer to be filled continuously. 

The <Nonstop Mode> is sometimes ref erred to as a circular 
memory. The captured information increments from the 
beginning of the buffer to the end of the buffer. As 
information continues to be received, the pro1ocol analyzer 
moves back to the beginning of the memory buff er and starts 
writing over information previously stored. This process of 
writing over previously stored information continues until the 
<Stop Monitor> sof tkey is pressed. 

stores network information in the receive buff er until it is full 
and the protocol analyzer stops acquiring data. 

The <Until Full> mode is sometimes referred to as a linear 
memory. The captured information increments from the 
beginning of the buffer to the end of the buff er. In contrast 
to the <Nonstop Mode>, the <Until Full> mode does not 
continuously write over previously stored information. When 
the Receive Buff er is filled, the protocol analyzer halts the 
monitor function and automatically goes to the <Examine 
Data> Menu. 
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<Start Monitor> 

<Stop Display> 

<Start Display> 

initializes the Receive Buff er and causes the protocol analyzer 
to start storing information in the same order that it appears 
on the local area network. 

Several messages are displayed at the beginning of <Start 
Monitor> to show the status of the protocol analyzer during 
the acquisition cycle: 

Loading filter hardware 
Initializing Receive Buffers 
Acquiring data. Waiting for incoming frames 

The task of storing the frames in the Receive buffer is 
happening in realtime at 10 Mbits/sec. The frames can not be 
displayed in real time. As the display is updated, the last frame 
stored in the Receive Buffer is displayed next. 

When the monitor operation is ended, frames are displayed in 
the consecutive sequence they occurred on the network. 

stops displaying new frames as they are stored into the Receive 
Buffer. Although the protocol analyzer stops displaying new 
frames, additional frames continue to be stored in the 
<Nonstop Mode> or until the memory is full in <Until Full> 
Mode. 

A reason to stop the display might be when acquisition is 
occurring slowly, you can examine some frame in detail 
without having to wait until the buffer is full or not having to 
disrupt the frame acquisition. 

Changing the format at this point allows you to display the 
frame in another format. 

restarts the protocol analyzer displaying new frames as they 
are being loaded into the Receive Buffer. 
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<Stop Monitor> 

<Continue Monitor> 

<Examine Data> 

<Select Format> 

stops loading new frames into the Receive Buff er and displays 
the frames in the <Examine Data> mode. 

In the <Nonstop Mode>, the following status message is 
momentarily displayed: Run Suspended ; then the protocol 
analyzer goes to <Examine Data> mode to display frames in 
the Receive Buffer. 

Press the <EXIT> softkey to display the choice to either <Start 
Monitor> which reinitializes the Receive Buffer and throws 
away. the contents previously stored, or, to <Continue 
Monitor> which retains previously stored information, and 
starts filling memory from where it left off. 

lets the protocol analyzer resume loading new frames into the 
Receive Buffer and displaying frames in the <Examine Data> 
Mode. 

is a softkey that also may be selected from the Top Level 
Menu. The function of the <Examine Data> softkey is to 
provide an easy method of viewing the network frames stored 
in the Receive Buffer. 

<Examine Data> softkeys are explained in detail in the 
<Examine Data> Menu chapter. 

is a softkey from the <Examine Data> Menu. 

In this monitor mode, <Select Format> softkey lets you change 
the display format of information stored in the Receive 
Buffer. By changing the display format, you can exclude 
unwanted information and identify more easily information 
that is important to you. 

Choices available from the <Select Format> softkey are 
explained in detail in the <Examine Data> Menu section. 
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< Monitor Network > Soft LED Indicators 

In <Monitor Network> operation, characters are provided to indicate the following 
activities: 

The protocol analyzer has detected a collision. 
The protocol analyzer is receiving a frame. 

These activities are indicated by characters shown below the softkeys at the lower right 
corner of the display. 

T .. C· ·~ 

Each character is displayed in normal video when there is no activity, that is, the 
function is "Off". Characters are displayed in inverse video when their function is 
active or "On". 

T 

c 

R 

indicates the protocol analyzer is transmitting on the network. 

NOTE 

Monitor operation is a unobtrusive or passive operation; the 
protocol analyzer will never be transmitting during monitor 
operation. The "T" LED is only used during <Execute 
Programs> operation. 

indicates collisions are occurring on the network. Hardware for the 
collision counter detection circuit has detected a collision. 

indicates the protocol analyzer is receiving a frame. The LED turns 
on when ever a frame passes through the Runt frame filter. Only 
frames greater than 512 bits will turn this soft LED on if the Runt 
Frame Filter is enabled in the <Hardware Functions> Menu. 
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WHEN ARE THE SOFT LEDs DISPLAYED IN MONITOR OPERATION? 

The soft LEDs are displayed during the following monitor operations: 

1. <Monitor Network> mode is running. 

2. <Monitor Network> mode has run and has been manually stopped with no 
frames received after the monitor has stopped. 

WHAT IS THE DISPLAY TIME FOR THE SOFT LEDs? 

Short Display 

Long Display 

Since the frames on a LAN are being transmitted at 10 
Mbits/sec, there are times when the soft LEDs will be on too 
briefly to notice. 

In contrast, there are times when the soft LEDs will be on 
longer than the duration of an event. 

For the Collision and Receive LEDs, the duration depends on 
the amount of traffic on the network. 

LED on continuously 
occurs when the network Joad is rece1v111g more than one 
frame/second and less than 64 frames/second. 

LED on continuously with low blink rate 
occurs when the network load is greater than 64 
frames/second and some inter-frame spacing is greater than 
200 ms. 

LED on continuously with occasional flicker 
Occurs when the network load is greater than 64 
frames/second and all inter-frame spacing is less than 200 ms. 

LED always off or blinks at one second rate 
occurs when the network load is less than one frame/second. 
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WHAT DISTORTS THE LED DISPLAY? 

Transmit 

Collision 
& Receive 

(Not active in monitor mode.) 

The soft LEDs do not operate in real time; a collision can 
occur or a frame can be received but the indication is not 
displayed until some time later. 

The time lag can range from one millisecond to one second. 
The maximum time lag occurs when the network is very 
lightly loaded (less than 64 frames/second). 

<MQnitor Network> Menu 17·8 



< Monitor Network > Anomalies 

Repeating Displays 

The HP 497 lS does not display all frames while monitoring the network. Since frames 
are transmitted at 10 Mbits/sec, the display skips some frames and updates with the 
most recently stored frame in the Receive Buffer. 

In <Monitor Network> <Nonstop Mode>, if you are monitoring a repeating group of 
frames on the network, the protocol analyzer may appear to be displaying only a few 
of the frames. This may happen when the display cycle of the protocol analyzer 
synchronizes with the frames appearing on the network. 

To assure yourself that all the frames are being received, you may want to stop the 
monitor function and use <Examine Data> softkey to verify that other frames are 
indeed being captured. 

No Frame Number Displayed 

Frame numbers are not displayed when you monitor the network in <Nonstop> mode. 
After you stop the monitor, the frames will be numbered with the oldest frame in the 
buffer starting as number 1. 
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18 
< Disc Functions > MENU 

This chapter describes the disc functions and the softkeys used to control the mass 
storage operations. 

The <Disc Functions> softkey functions provide mass storage capability for the HP 
497 lS Protocol Analyzer. 

This chapter includes: 

• <Disc Functions> Softkey • <Copy Files> Introduction 
Selections 

• Copying <Analyzer Files> 

• Introduction To Disc 
Functions • Copying <All Files> 

• Selecting A Volume • Copying <Unique Files> 

• Listing The Directory • Formatting A Volume 

• Deleting A File • Compressing A Volume 

• Saving A File • <Disc Functions> In 
Remote Mode 

• Loading A File 

• Copying A File 
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< Disc Functions > Softkey Selections 

Disc Functions 
Select Volume 

List Directory 

Delete File 

Save File 

Load File 

Copy Files 

OTHER CHOICES 

Format Volume 

Compress Volume 

EXIT 
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Introduction To Disc Functions 

<Disc Functions> softkey provides many conveniences for analyzing a Local Area 
Network. Programs, messages, node lists and filters can be created for application on 
your particular system and saved to a disc drive. 

The <Log Frames To Disc> program command in <Edit Programs> Menu lets the HP 
497 IS log frames directly to the disc drive as the frames are occurring on the network. 
This lets you take advantage of the larger storage capacity of the disc drives. 

In non-logging modes, after the HP 497 lS Protocol Analyzer captures frames occurring 
on the Local Area Network, you can manually transfer the frames to the larger storage 
capacity of a disc drive. 

Equally as important as the increased data storage is the easy storage and recall of 
previously defined setup information that you can create to control the HP 497 lS 
operation. Examples of functions desirable to store on a disc are: 

User defined node name list 
User defined filters 

User created programs 
User created messages 

The <Disc Functions> menu lets the HP 497 lS Protocol Analyzer perform the 
following data storage and transfer functions. 

Initialize discs or volumes. 

Save files from the protocol analyzer onto discs or volumes. 

Load files from volumes into the protocol analyzer. 

Copy files from one volume to another disc volume. 

Delete files from volumes. 



Discs supplied with system. 

Several discs are provided with the HP 497 lS protocol analyzer system. These disc are: 

DISC LABEL 

LANSYS 

LAN COD 

HP 4971S 
TUTORIAL 

92192A 

DESCRIPTION 

Includes the operating system software and some operating 
tables. 

Includes code unique to protocol analyzer functions. 

is a self-paced tutorial supplied to introduce you to the 
basic functions of the protocol analyzer. 

Box of ten 3 1/2 inch floppy discs 

With HP 9122D Dual Disc drives, LANSYS and LANCOD must be installed in the disc 
drive each time the protocol analyzer is powered on. 

With Winchester drives, you permanently store LANSYS and LANCOD on the hard 
disc after the initial power up procedure. 
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<Select Volume> 

Selecting A Volume 

lets you to select the disc volume to use for your mass storage 
operations. 

Up to three disc drives can be supported by the HP 4971S. 
The HP-18 switch address settings on a disc drive determines 
the volume unit numbers displayed by the analyzer when you 
press the <Select Volume> softkey. 

In the chapter "Installing The HP 497 lS," the section "Set The 
HP-lB Address Switches" describes the options for setting the 
address switches for system disc drive(s). 
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<List Directory> 

Listing The Directory 

displays a directory list of files contained in the selected 
volume. 

The <List Directory> function recognizes and displays Pascal 
TEXT and CODE files. If another type of file is found, the 
file is labeled as OTHER in the type field. 

DIRECTORY OF VOLUME : (volume name) 
VOLUME SIZE (BYTES): 630784 LARGEST AVAILABLE SPACE (BYTES): 21248 

FILE # NAME 

1 CNFG 
2 new 
3 sys71 
4 Netwrk1 
5 Nli st 

VOLUME SIZE 

LARGEST 
AVAILABLE SPACE 

TYPE SEQUENCE DATE SAVED TIME SAVED SIZE (BYTES) 
. . . . . . . .. . . . . . .. . .. . . ............ .. . -.. - .. - ....... "' 

Conf ig 0 15·Apr·85 10:01 :01 1024 
Data 0 16·Jun·85 01:03:39 56780 
OTHER * 09·Mar·86 12:15:22 237954 
Network 0 17·Jun·86 13:01:55 2283 
Nodes 0 17·Jun·86 09:30:02 743961 

Printing The Directory 
If your system has an HP ThinkJet printer, press SHIFT and 
PRINT keys to print the complete directory. 

displays the total size in bytes of the selected volume. 

is the largest contiguous space available. This may be space 
bet.ween existing files or space at the end of the files. The HP 
497 lS does not fragment files when performing a save file or 
copy file operation. 

You can use this number to see if you have enough room to 
save or copy an additional file to the current volume. 

If files have been deleted, use the <Compress Volume> softkey 
to move all free file space to the end of the volume. 
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TYPE field indicates the type of file. Protocol analyzer files include: 

Application 
Configuration 
Data (frames) 
Data (log-to-disc) 

Filter 
Message 
Network 
Node 

TEXT, CODE, or OTHER files are not HP 497 IS user defined 
protocol analyzer files. 

SEQUENCE number is used only for files saved from the protocol analyzer. 

DATE 

TIME 

OTHER, TEXT, and CODE files have an asterisk (*) in the 
sequence column. 

When large files are saved to a disc, there may not be enough 
room to save all of a file on one disc. The HP 497 lS prompts 
you to insert a new disc when the current disc capacity has 
been filled. The HP 497 IS automatically assigns sequence 
number one to the first disc and then increments the sequence 
number for the remainder of the file created on the next 
disc(s). 

is the day, month, and year the file was saved in the protocol 
analyzer. 

If the. date is not set in the <Set Date> Menu when the 
protocol analyzer power is turned on, the "DA TE" field 
defaults to the HP 497 lS software revision date. 

is the hour, minute, and second the file was saved in the 
protocol analyzer. 

If the time is not set in the <Set Time> Menu when the 
protocol analyzer power is turned on, the "TIME" clock starts 
from zero and <List Directory> TIME is not relevant to the 
actual time of day the file was stored on disc. 

<Disc Functions> Menu 18-6 



<Delete File> 

Deleting A File 

softkey lets you remove an unwanted file from a selected 
volume. 

Press the <Delete File> softkey to display a list of the types of 
files on the selected volume. 

After the type of file softkey is pressed, a prompt is displayed 
to enter the file name to be deleted. All of the files that 
match the file type you selected are displayed as softkey 
clH>ices. Press a softkey type the file name from the keyboard. 
If you enter the file name from the keyboard, press RETURN 
key to complete the entry. 

Are You Sure?. 
After you enter a file name you want to delete, a prompt is 
displayed to be sure that you have identified the correct file 
and really want to delete the information. Press the <YES> 
softkey to execute the delete command. 

One File At A Time 
For safety, only one file may be deleted at a time. A wild 
card can not be used to delete multiple files in one operation. 
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<Save File> 

Network 
File 

Saving A File 

lets you copy a file from the protocol analyzer to a selected 
volume. The original information is left intact in the protocol 
analyzer. 

After you press the <Save File> softkey, the softkeys change to 
display a choice of the type of file to be saved. Types of files 
that can be saved from the protocol analyzer include: 

Data 

File 

Node 
Fi le 

Filter 

Fi le 

Message 

Fi le 

Program 
File 

OTHER 
CHOICES 

EXIT 

<OTHER CHOICES> 

Conf ig. 

File 

<Conflg File> 

OTHER 
CHOICES 

EXIT 

softkey lets you copy the current HP 4971 S 
configuration into a file. The configuration file 
contains data rate, hand shaking and protocol 
information for communicating over the RS-232 port as 
well as set-up information for several menus. 

Set-up items included in the configuration file include: 
Passwords 
Autostart file 
Default volume 
<Examine Data> Menu data formats 
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<Save File> (cont.) 

<Network File> softkey copies the following information from the 
protocol analyzer onto the disc. 

User defined node name list 
User defined filters 
User defined messages 
User defined programs 

If no Network file exists on the selected volume, the 
display prompts you to enter a file name. If network 
files already exist, the <Network File> softkey requires 
you to choose between creating a new file or re-writing 
the file to an existing file name. 

<Re-write Existing> 
softkey displays the names of network files existing on 
the selected volume. 

Press a displayed softkey representing the file to be 
replaced to immediately execute storing the current 
network files in the protocol analyzer to that disc file, 
or, enter the name of an existing disc file from the 
keyboard and press RETURN to execute saving the 
network file. 

<Create New File> 
softkey prompts you to enter a new file name. Volume 
file names can be up to seven keyboard characters. 
Leading spaces are deleted. Spaces between characters 
are replaced with an underscore (_). Characters not 
valid for volume file names are: 
@ . (period) 
# I CTRL-x (control characters) 
$ 

After a name is entered for <Create New File>, press 
RETURN key to execute storing the network setups 
from the protocol analyzer to the new file. 
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<Save Fiie> (cont.) 

<Data File> softkey lets you copy Data Files from the protocol 
analyzer's Receive Buffer onto a selected volume. 

If no data file exists on the selected volume, the display 
prompts you to enter a file name. If data files already 
exist, the <Data File> softkey requires you to choose 

·between creating a new file and re-writing the file to an 
existing file name. 

<Create New File> writes the file to a new fiie name. 
<Re-write Existing> removes information from an 
existing file and writes the new information in its place. 

To save network frames from the Receiver Buffer to a 
data file on the volume, you have to decide what 
portion of the Receive Buffer you want to copy. 

Up to 15 combinations of network message frame 
groups can be stored in one volume file. Softkey 
choices let you select frames to copy. 

<Range Of Frames> 
<Single Frame> 
<Marked Frame> 
<All Frames> 
<Save The List> 
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<Save File> (cont.) 

NOTE 

Frames are saved with the same frame number they have in 
the Receive Buffer. If a frame is saved more than one time, 
it is shown with the same frame number each time it is 
displayed. 

An example is shown below of <Save File> softkey with all 15 
available elements defined with frames to be saved from the 
Receive Buff er Data File. Notice that several frames are 
copied in more than one element. 

FRAMES IN THE LIST (15 elements maximum) : 

1. RANGE OF FRAMES FROM # __ 4 TO # __ 9 
2. SINGLE FRAME # __ 2 
3. RANGE OF FRAMES FROM # __ 1_4 TO # 20 
4. RANGE OF FRAMES FROM # ~~3_1 TO # ~ 

5. SINGLE FRAME # ~ 

6. MARKED FRAMES 
7. RANGE OF FRAMES FROM # ~ TO # __lQQ 
8. RANGE OF FRAMES FROM # ~ TO # 500 
9. RANGE OF FRAMES FROM # ~ TO # ~ 

10. SINGLE FRAME # ___i2Q 
11. SINGLE FRAME # __ 1 
12. SINGLE FRAME # 250 
13. RANGE OF FRAMES FROM # ~ TO # 600 
14. RANGE OF FRAMES FROM # __ 1_0 TO # ~ 

15. SINGLE FRAME # 625 
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<Save File> (cont.) 

<Range Of Frames> 
lets you choose a group of consecutive frames to be copied 
from the Receive Buffer Data File to a selected disc. The 
prompt for choosing the range of frames is: 

RANGE OF FRAMES FROM # TO # 

The frame numbers ref er to the numbers assigned to each 
frame as it is viewed in <Examine Data> Menu. To specify a 
number range, use numeric keys from the keyboard in the 
prompt, ·From # __ , and then press the RETURN key. 
Enter the ·To # frame number and press the 
RETURN key. 

If you want to know the last frame number, enter a number 
you know is greater than the last stored frame number such as 
999999 and press the RETURN key. The last frame number 
available in the Receive Buff er is displayed in the field. 

Frame numbers can overlap or be duplicated in different 
combinations or data files. 

<Single Frame> 
lets you choose one specific frame number to be copied from 
the Receive Buffer Data File. 

A <Single Frame> choice may be duplicated in other frame 
selections to be saved to the disc. 

Enter the single frame number and then press the RETURN 
key to complete the entry. 

If no additional frames need to be saved, press <Save The List> 
softkey. 
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<Save File> (cont.) 

<Marked Frames> 
stores all frames from the Receive Buffer that have been 
identified by the <Mark Frame> softkey in <Examine Data> 
operation. 

<All Frames> 
lets you save all frames in the Receive Buffer. <All Frames> 
can be used by itself to save the entire group of frames in the 
Receive Buffer or it may be used in combination with the 
other softkeys for saving frames. 

<Save The List> 
immediately executes saving the frames identified in the list by 
<Range Of Frames>. <Single Frame>, <All Frames>, and 
<Marked Frames> softkeys. 

If you press <Save The List> softkey and no frames have been 
identified to be stored, an empty file is generated. 

Save Timers And Counters? 

After you press <Save The List>, the protocol analyzer asks if 
you want to also save the Timers and Counters with the 
current data file to be saved. Press <YES> to begin saving the 
data list and the counters/timers information. Press <NO> 
softkey, to save only the previously defined data list. 
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<SAVE FILE> (cont.) 

<Node File> 
<Filter File> 
<Message File> 
<Program File> 

You can save each of these individual files that you 
have created in <Setup Analyzer> Menu to a volume 
you select. 

After one of the above menus is created, go to <Disc 
Functions> menu. 

Press the <Save File> <xxxxxxx File> softkey and the 
protocol analyzer prompts you to choose between 
saving the file to to a new file name or re-writing an 
existing file 

Press <Create New File> to save the <xxxxxxx File> to a 
new file name. 

Press <Re-write Existing> to save the menu or 
information to an existing file name. Re-write removes 
the old file information and then writes the new 
information. 
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<Load File> 

Loading A File 

lets you copy an HP 497 lS file from a selected volume into 
the HP 497 lS protocol analyzer. 

Press the <Load File> soft.key to display the selection of files 
available on the selected disc. Depending on which file type 
you select, soft.keys display names for that type from the 
selected volume directory. 

Press the soft.key name of the file you want loaded into the 
protocol analyzer to immediately start loading the file. 

Append Or Overwrite Current Node List? 
When you load a network or node file into the protocol 
analyzer and the node list already has nodes defined, the 
display prompts you to choose whether to append or 
overwrite the current node list. 

<Append Nodes> soft.key adds the new names to the current 
node list. 

<Overwrite Nodes> soft.key deletes the current node list and 
writes the file into the node list. 

Status Messages 
Status messages are displayed in the upper left corner during 
the load operation. For example: 

Loading Nodes 

Loading Frame # in to Buff er # 

When the file is loaded, a status message is displayed above the 
soft.keys: 

•(your file name)' loaded. 

<Disc Functions> Menu 18·15 



< Copy File > Introduction 

<Copy Files> The HP 497 lS can copy a file from one volume into another 
volume. The copy function is softkey controlled. 

Softkey selections copy a single file or all files from one 
volume to another. You can use a wild card to copy files with 
common characters from one volume to another. You can 
copy non HP 497 lS files. 

Jn any of the copy file modes, when a file to be copied 
already exists on the TO volume, the file is over written. 

NOTE 

Floppy discs must be initialized by the HP 4971S system 
before you can copy to the disc. 

After you press <Copy Files> and select a volume to copy FROM, the protocol analyzer 
displays the following softkeys: 

<Analyzer Files> <All Files> <Unique Files> 

Files types that may be in each of these file groups include: 

<Analyzer Files> 

Config file 
Network file 
Data file 
Node file 
Filter file 
Message file 
Program file 
Log-to-disc 
Application 

<All Files> 

Includes all 
files stored on 
the FROM volume. 
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<Unique Files> 

May be any 
file. 
This includes 
analyzer files 
or other system 
files. 
Wild card (@) 
can be used. 



<Analyzer Files> 

<All Files> 

<Unique Files> 

softkey lets you copy any of the protocol analyzer file types 
listed on the previous page. 

In <Analyzer Files> copy operations, only one file may be 
copied at a time. Softkey operation is provided for quick file 
copy operation. 

softkey lets you copy all files (analyzer files and unique files) 
from one volume to another volume in one operation. 

softkey lets copy protocol analyzer files as well as files other 
than user defined protocol analyzer files. Other file types may 
be system files. 

A "wild card" feature in the <Unique Files> operation lets you 
copy more than one file at a time. 

Each of these copy file groups is discussed in detail on the following pages. 
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COPYING < ANALYZER FILES > 
<Analyzer Files> lets you copy any of the files you use for protocol analyzer operation. 
Using <Copy Files> <Analyzer Files> lets you copy one file at a time. Softkey are 
provided to let you quickly move through the copy operation. 

The different types of files used for protocol analyzer operation include: 

Configuration File 
Network File 
Data File 
Node File 
Filter File 

Message File 
Program File 
Log-to-disc File 
Application File 

PROCEDURE 

1. Press <Copy Files> softkey. 

2. HP 4971S prompts: Copy file FROM which volume? 

3. Press a softkey for the number of the FROM volume. 

4. HP 497 lS displays: FROM: #(volume number:),(name of volume) TO: 

For example: FROM: #3, SAVE1 TO: 

Copies a file from volume #3:. Volume #3: is named SAVEL 

5. The protocol analyzer reads the directory of the FROM volume and displays 
soft keys: 

<Analyzer Files> <All Files> <Unique Files> 

6. Press <Analyzer Files> softkey. 

7. HP 497 lS displays only the analyzer type files that are currently on the 
selected volume. 

8. HP 497 lS prompts: Choose a file type to copy. 
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PROCEDURE: Copy <Analyzer Files> (cont.) 

9. Press a softkey for the file type you want to copy. 

10. HP 4971S displays softkey choices for the files currently existing on the 
selected volume. 

11. HP 497 lS prompts: Select softkey or enter valid name 

12. Press a softkey for the file you want to copy. 

13. HP 497 lS lists the file name and file type you just selected and prompts: 
Copy file TO which volume? 

14. HP 497 lS displays softkey choices for the volumes available on your system. 

15. Press a softkey for the volume destination you want. 

16. HP 497 lS displays the name, type, and size of the file you have selected. 

17. HP 497 lS displays softkeys to let you rename the file on the TO volume or to 
begin copying to the current file name. 

<Begin Copy> 
<Begin Copy> causes the protocol analyzer to begin the copy operation. 

<Change Name> 
<Change Name> lets you change the name of the file in the TO volume. 
Press the softkey, <Change Name>, and enter the new name. 

Volume file names can be up to seven characters. Leading spaces are 
deleted. Spaces between characters are replaced with an underscore (_). 
Press RETURN key to complete the entry. Characters not valid for volume 
file names are: 

@ 
# 

$ 
I 

. (period) 
CTRL-x (CONTROL characters) 

Press <Begin Copy> to start the copy function. 
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Copying < All Files > 
In some applications, you may need to copy the entire contents of a volume. This can 
be done in one operation and is easier than copying a volume file by file. 

When you need to copy all the files from a hard disc to floppy disc(s), you may not 
have enough room on the floppy disc. The protocol analyzer prompts you when to 
install a new floppy disc. 

PROCEDURE: 

l. Press the <Copy Files> softkey. 

2. HP 497 lS prompts: Copy file FROM which volume? 

3. HP 4971S displays softkeys for you to select which group of files to copy 

4. Press <All Files> softkey. 

5. HP 4971 S prompts: Copy file TO which volume? 

6. Press a softkey for the volume you want to copy files TO. 

7. The protocol analyzer displays the copy FROM volume, the copy TO volume, 
and a list of the files to be copied. 

You can scroll the file list with the cursor arrow UP and DOWN keys. 

8. HP 497 lS displays softkeys to execute the copy function, <Begin Copy> or to 
quit the copy function, <Abort Copy>. 

9. Press <Begin Copy> softkey to start the copy function. 
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Copying < Unique Files> 

<Unique Files> lets you copy files used for protocol analyzer operation as well as other 
system files. System files are labeled OTHER, TEXT, or CODE in the TYPE field of 
directory listings. 

You can copy one file at a time, or, you can use a wild card to copy multiple files. 

PROCEDURE Copy <Unique Files> (cont.) 

l. Press <Copy Files> softkey. 

2. HP 497 lS prompts: Copy file FROM which volume? 

3. Press a softkey for the FROM volume you want to copy from. 

4. HP 497 lS displays: FROM: #(volume number:),(volume name) TO: 

For example: FROM: #3, SAVE1 TO: 

Copies a file from volume number 3. Volume #3: is named SA VEI. 

5. The protocol analyzer reads the directory of the FROM volume and displays: 

<Analyzer Files> <All Files> <Unique Files> 

6. Press <Unique Files> softkey. 

7. HP 497 LS displays a data entry field and the prompt: 

Enter the file name you wish to copy. 

8. Enter a file name and press the RETURN key. 

File name syntax and wild cards are described on the following pages. 
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"ANALYZER" FILE NAME SYNTAX 

nnnnnnns.t 

AA A--- field type 

11 
II 
II 
11 
II 

D (Receive Buffer data) 
d (Log·to·disc data) 
N (Network) 
n (Node> 

II ____ separate with C.) 

I 
I ____ disc sequence number 

F (Filter) 
M (Message) 
C (Configuration) 
A (Application) 

(Needed only with Analyzer files) 

-------file name ( 7 char max ) 

"UNIQUE" FILE NAME SYNTAX 

n n n n n n n n n n . TYPE 

___ field type 
CODE or TEXT 

____ separate with (.) 
(TEXT and CODE files only) 
(TYPE entry not needed for OTHER file types.) 

------- file name ( 10 char max ) 

COPY FILE SYNTAX FILE NAME SEQUENCE FILE TYPE 
msgAl.M = msgA 1 M (Message) 
setuplO.C = setup! 0 C (Config) 
RonnO.n Rona 0 n (node) 
BADDATO.D BADDAT 0 D (Data) 

Rectangle.TEXT = Rectangle * TEXT 
JOB_SUMRY JOB SUMRY * OTHER 
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File Names 
ANALYZER files -- names are limited to 7 keyboard characters and 
must be followed by the disc sequence number and TYPE character. 

UNIQUE files -- names are limited to 15 characters. If file is TEXT 
or CODE, enter file name and .TEXT or .CODE . 

If file is OTHER type, enter just the file name and press RETURN 
key. 

Leading spaces in file names are deleted. Spaces between characters 
are replaced with an underscore L). Characters not valid for volume 
file names are: 

@ 
# 
$ 

I 
. (period) 
CTRL-x (control characters) 

WILD CARD -- can be used to copy more than one file at a time. 
See wild card description on next page. 

Sequence number 
When large files are copied to discs, there may not be enough room 
to save all the file on one disc. The HP 497 lS prompts you to insert 
a new disc when the current disc capacity has been filled. 

Type ANALYZER files use the letter cases shown below to indicate the 
type of file: 

D (Data saved from F (Filter) 
Receive Buffer) M (Message) 

d (log-to-disc data) c (Configuration) 
N (Network) A (Application) 
n (node) 

UNIQUE files use the following names to show type of file: TEXT, 
CODE. 
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<Copy Files> SYNTAX (cont.) 

WILD CARDS 

The wild card character, (@), lets you copy more that one file at a time. If several files 
have names that share common characters in sequence, you can copy all the files in one 
operation. 

Wild cards can be used with Analyzer Files or with Unique Files. The file is copied 
with the same sequence and type information as the original file. 

Examples: DAT@ 

@CODE 

@DEF@ 

@O.D 

copies all files beginning with DAT 

copies all .CODE files. 

copies all files with the consecutive letters DEF any 
where in the name. 

copies all Data files with sequence number 0. 
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Formatting A Volume 

<Format Volume> softkey lets you format (or initinlize) a volume on a 
Winchester disc or a 3 1 /2 inch floppy disc to the HP 497 lS 
system. 

To format a volume, use the following procedure. 

WARNING 

Formatting a used volume erases the current files. Back up 
files you need to keep. 

PROCEDURE: 

1. If the volume you want to format is a floppy disc, check that the write 
protect tab on the floppy disc is in the write enable position. (Slide tab 
toward center of disc.) 

2. If you are formatting a floppy disc, install the floppy disc to be formatted in 
a disc drive slot. 

3. Press <Format Volume> softkey. 

4. HP 4971S prompts: Select a volume to format. 

5. Softkeys are displayed for the volumes connected to your HP 497 IS system. 

Press the softkey for the volume you want to format. 

WARNING 

If you have a Winchester disc drive with more than one 
volume on the hard disc, if you select any one of the 
volumes to format, all volumes on the hard disc are 
formatted. 
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6. HP 497lS displays volume number, the current logical volume name, and how 
many files are currently on the volume. 

7. HP 497 lS prompts: Do you want to proceed with the formatting? 

8. Press <YES> softkey to format the volume and HP 497 lS displays: 

Volume formatting in progress. 

Press <No> or <EXIT> softkey if you do not want to proceed. 

9. After the volume is formatted, 

HP 4971S prompts: Volume name for #X 

If the volume has been formatted previously and named, the old name is 
displayed in the prompt. If the volume is new, the name field is blank. 

10. If you want the old name, press RETURN. 

11. If you want a new name, enter the new name and press RETURN key. 

Volume names may be up to six keyboard characters. Leading spaces in 
volume names are deleted. Spaces between characters are replaced with an 
underscore L). Characters not valid for volume file names are: 

@ $ I . (period) 
# = CTRL-x (control characters) 

12. After a volume is formatted, 

HP 497 lS displays: Formatting successful. 

The name you give to a volume is displayed when you do a directory of the volume. 

DIRECTORY OF VOLUME : (volume name) 
VOLUME SIZE (BYTES): 630784 LARGEST AVAILABLE SPACE (BYTES): 21248 

FILE # NAME TYPE SEQUENCE DATE SAVED TIME SAVED SIZE (BYTES) 
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Compressing A Volume 

<Compress Volume> softkey lets you compress or compact the files stored in a 
volume. 

The directory is checked for current files. Valid existing files 
are relocated to recover space previously occupied by deleted 
files. 

After a volume is compressed, all free space is contiguous at 
the end of the compressed volume. 

Compressing a volume lets you have access to all the free 
space on the volume. You now have the maximum space 
available displayed when you view the "LARGEST 
AVAILABLE SPACE (BYTES)" field of a volume directory 
list. 
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< Disc Functions > IN REMOTE MODE 

When two protocol analyzers are connected for remote operation, the slave protocol 
analyzer, at the remote site, makes all the measurements on the local Area Network 
(LAN) it is connected to and the slave also executes the disc function commands. 

Selecting A Volume In Remote Mode 

When a remote link is established and you press <Select Volume>, <Copy Files>, 
<Compress Volume>, etc. the display prompts you to choose either <Master> or <Slave>. 
Select the station that has the mass storage devices you want to use. Softkeys then 
display the choice of volumes available at the selected station. 

Copy Functions In Remote 

In remote mode, you can perform the following copy functions: 

Slave volume to slave volume 
Slave volume to master volume 
Master volume to slave volume 
Master volume to master volume 

OPERATING EXCEPTIONS FOR DISC FUNCTIONS IN REMOTE MODE 

Remote operation does not allow two primary functions normally available in the 
<Disc Functions> Menu. These functions are: 

Log-To-Disc 
Format volumes 

Log-to-disc - If you try to use <Execute Program> and the program has a 
log-to-disc command, the command is ignored. The rest of the program executes 
normally. 

Format volumes - During remote operation, you can not format volumes at either the 
master or the slave protocol analyzer. Volumes can be formatted only when a station is 
in local control. 
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19 
< Examine Data > MENU 

The <Examine Data> Menu lets you easily control the format of displayed network 
traffic for quicker recognition of frames that interest you. 

This chapter includes: 

• <Examine Data> Display 

• <Examine Data> Softkey Selections 

• <Examine Data> Softkey Descriptions 

Finding Frames 

Selecting A Frame Display Format 

Selecting Frame Header Formats 

Selecting Datafield Character Formats 

Displaying Data In Filter Formats 

Selecting Timestamp Measurements 

Selecting Timers And Counters 

• Displaying Frame Errors 
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#1 Mar 9@ 6.10.34.55533 Len 61 Filters 0 ............... No error 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA-99·76·54 .!..YE! OA·OB 
3 15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E-75·6D This is Frame Num 
4 32 62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46 ber 0001's Data F 
5 49 49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E ield content. 
6 
7 #2 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 

#3 

#4 

Mar 9 Cil 6:10:34.66893 Len 61 Filters 0 ............... No error 
Destination 01·23-45·67·89-AB ....... . 

15 54·68·69·73· ..•..... This ..... . 
32 62·65. 72 ...... . ber ..... . 
49 49·45·4C·44·20· ••.•.••• ield •.••• 

Mar 9@ 6:10:35.01446 Len 61 Filters 0 ............... No error 
Destination 

15 54·68·69·73· ...... . This ..... . 
32 62·65·72· ....... . ber ...... . 
49 49·45·4C·44·2E ..... . i eld ..... . 

Mar 9@ 6:10:35.12345 Len 61 Filters: 0 ............... No error 

STATUS MESSAGE FIELD 
ERROR MESSAGE FIELD 

Next Previous Scroll Go to Timers & Select OTHER 
Frame Frame Frames Frame # Counters Format CHOICES 

<OTHER CHOICES> 
Next Previous Scroll Go to Mark/ 

Marked Marked Marked Trigger Unmark 
Search 
Buffer 

OTHER 
CHOICES 

Figure 19-1. Default <Examine Data> Menu Display. 

EXIT 

EXIT 
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< Examine Data > Display_ 

In the default <Examine Data> display, messages are displayed in detailed format. The 
protocol analyzer displays a physical header with each frame to give additional 
information about the frame. In addition, an Ethernet header is displayed. The data 
field is displayed in a hex and ASCII 8 format. 

Figure 19-l shows an <Examine Data> default display for network messages. The 
numbers on the left side of the display are for explanation use and are not part of the 
display. 

Line 1 

Line 1 is the physical header included with each frame by the protocol analyzer. It 
contains the following details: 

Frame Number 

Frame number 

The physical elements, which includes: 

Time Stamp 
Message length 
Filters matched 
Error indicator or frame status 

The "#l" in line l indicates that this is the first message stored 
in the protocol analyzer memory. Following messages are 
counted in the sequence they were stored in the Receive 
Buffer. 

The frame number is always shown in <Examine Data> 
displays. 

The frame number is not shown while <Monitor Network> 
Menu is operated in <Nonstop Mode>. 



<Examine Data> Display 

Time Stamp 

Message Length 

Mar 9 @ 6:10:34.55533" is the month, day, hour, minute, and 
second the message was stored in memory. The seconds are 
displayed in microseconds. 

The default time stamp display mode is <Date/Time>. This 
references all frames stored to the time when each frame 
occurred on the network. 

The calculated length of the message, in bytes, is displayed in 
the "Len" Field of line 1. 

The frame length is calculated by the protocol analyzer and 
includes all the information fields, which are: Destination 
Address, Source Address, Length (Length in Ethernet, Type in 
IEEE 802.3), and Data fields. Preamble and FCS Fields are 
not included in the message length. 
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<Examine Data> Display 

Filters field is a display showing currently defined filters and if a 
filter match occurred when the frame was captured. 

Filters 0 ••••••••••••••• 

Indicates the first filter defined is matched by this message. 

Filters 0123456789ABCOEF 

Up to 16 filters can be defined using the <Edit Filters> 
function. This example indicates all 16 available filters are 
defined and have been matched by the current message. 

Filters Ox •••••••••••••• 

Indicates Filter 0 was defined and matched in a message. 
Filter 1 was defined but did not find a match. 

No filter match is indicated by the "x" character. 

Only filters 0 and 1 are defined. All the other filters that are 
undefined are indicated by the "." character. 

The Filters: Field uses the filters defined when the data was 
captured. Because of this, if you edit an existing filter to no 
longer match a frame and again look at the same data in the 
Receive Buffer, the <Examine Data> display still indicates a 
match. If you delete a filter that matched a frame, that filter 
position is displayed as undefined. 

If you create a new filter and return to examine the previously 
captured data, the <Examine Data> display shows an x to 
indicate the new filter exists. It does not show if a match 
occurred with the new filter. 

To update the filters-matched field with frames already stored 
in the Receive Buff er, perform an <Execute Programs> with 
<Run From Buffer> selected. 
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<Examine Data> Display 

Error 

Line 2 

NOTE 

Frame errors are discussed in more detail in the "Displaying 
Frame Errors" section later in this chapter 

"No Error" indicates the frame was stored in the Receive 
Buffer with no errors detected. Possible errors that can be 
detected are indicated by the error messages: 

Runt Frame 
Jabbering 
Misaligned 

Corrupt Data 
Bad FCS 

The HP 497 lS can also detect combinations of these possible 
frame errors. The possible error combinations are listed below: 

Runt-Bad FCS 
Runt-Alignmt 

Jabr-Bad FCS 
Jabr-Alignmt 

In default <Examine Data> Menu, the protocol analyzer defaults to the <Ethernet 
Header> mode and displays the following information in line 2: 

Destination 
Address 

Destination Address 
Source Address 
Type 

The Destination Address consists of six bytes that identify 
where the message is being sent. Destination addresses are 
displayed in hexadecimal. 

The Destination Address field can be displayed as a functional 
node name by using the <Show Node Names> softkey. 
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<Examine Data> Display 

Source Address 

Type 

Line 3 

The Source Address consists of six bytes to identify where the 
message originated. Source Addresses are displayed in 
hexadecimal. 

The Source Address field can be displayed as a functional 
node name by using the <Show Node Names> softkey. 

The Type Field is displayed as two hexadecimal bytes. Type: 
is used in the Ethernet protocol to indicate the higher level 
protocol being used. The contents displayed in the Type Field 
will be bytes 13 and 14 of the frame contents. 

Line 2 can be changed to display the IEEE 802.3 header by 
pressing the <Select Format>, <Change Headers>, and <802.3 
Header> softkeys. The IEEE 802.3 header changes the Type: 
Field to Length: Field. The Length: Field also displays the 
contents of bytes 13 and 14. 

In the default display, line 3 of the <Examine Data> Menu contains the first line of text 
or data for the frame. In addition, the byte position for the first character on the line 
is shown at the left side of the display. 

Byte position 

Data 

On line 3, the " 15 " identifies that the first byte on line 3 is 
the 15th byte in the frame. Following lines use this column to 
indicate the location of the first byte on each line in the 
frame. 

The power on, or default <Examine Data> mode, displays 
characters in the message in hexadecima I and ASCII for ma ts. 
The frame data is first displayed in Hexadecimal with up to 17 
bytes per line. Each line is then interpreted on the right side 
of the display in ASCII format. 
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<Examine Data> Display 

Line 21 

Line 21 displays status messages. Examples of status messages are: 

No next frame 

Empty buffer 

Line 22 

Line 22 displays error messages. See the appendix section for error message 
information. 

Lines 23, 24 

The softkey selections that may be used to control operation of the HP 497 IS are 
displayed on lines 23 and 24. 
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Examine Data <Examine Data> Softkey Selections 
Next Frame 
Previous Frame 
Scroll Frames/Stop Scrolling 
Go To Frame # 

Timers & Counters 

Select Format 
Return To Data 

Detailed format 
Summary Format 
Filter Format 
Show Node Names 
Show Hex Addresses 
OTHER CHOICES 
Change Headers 

Suppress Physical Ethernet 802.3 
Headers Header Header Header 

Change Dataf ield 
Suppress 

Data 
Hex 
Data 

Character Hex/Char 
Data Data 

802.2 
Header 

Select * 
Data Code 

ASCII7 

** 
ime from Time from Time from Time 

ASCI 18 

btwn 
Change Timestamp 

Date/ 
Time 

Change Filters 
Start Frame # Trigger Frames 

Use First 
Matched 

Filter_O 

OTHER CHOICES 
Next Marked 
Previous Marked 
Scroll Marked 
Go To Trigger 
Mark/Unmark 
Search Buff er Search Next 

Search Prev 
Define Search 

Show Node Names 
Show Hex Addresses 
EXIT 
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Dest source 
Address Address 

Filters 
Matched 

*** 

Error 
Frame 

**** 

Dataf ield 
Pattern 

EBCDIC 

* Optional keyboards can be used to display other character codes. See appendix B. 

** ASCII 7 

ASCII 7 ASCII 7 ASCII 7 ASCII 7 ASCII 7 

No Par Par = 0 Par = Odd Par Even Par 

*** Filters 
Matched 

Filter 0 Filter 1 

**** Error 
Frame 

No Bad FCS Misalign Runt Jabber Any 
Error Error 

< Examine Data > Softkey. Descriptions 

The <Examine Data> softkeys are described in the following functional groups: 

Finding Frames 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Go To Frame #> 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

<Mark/Unmark> 

<Search Buff er> 
<Search Next> 
<Search Prev> 
<Define Search> 

<Dest Address> 
<Source Address> 
<Filters Matched> 
<Error Frame> 
<Dataf ield Pattern> 



Selecting Frame Display Format 

<Select Format> <Filter Format> 

<Detailed Format> <Summary Format> 

Selecting Frame Header Format 

<Change Headers> <Physical Header> 

<Suppress Headers> <Ethernet Header> 

Selecting Datafield Character Format 

<Change Dataf ield> <Character Data> 

<Suppress Data> <Hex/Char Data> 

<Hex Data> 

Displaying Data In Filter Formats 

<Use First Matched> 

<Filter_O> 

Selecting Timestamp Measurements 

<Change Timestamp> <Time From Start> 

<Date/Ti me> <Time From Frame #> 

Selecting Counters & Timers 

<Counters & Timers> 

<Show Node Name> 

<Show Hex Address> 

<802.3 Header> 

<802.2 Header> 

<Select Data Code> 
<ASCII 7> 
<ASCII 8> 
<EBCDIC> 

<Time From Trigger> 

<Time btwn Frames> 
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Finding Frames 

You can use softkeys in the <Examine Data> Menu to quickly and easily move through 
frames stored in the Receive Buffer to locate specific frames of interest to you. 

The following softkeys can be used to move through the stored frames: 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Scroll Frames> 

<Go to Frame #> 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

<Go To Trigger> 

<Mark/Unmark> 

<Search Buff er> 
<Search Next> 
<Search Prev> 

Remember that in addition to the above softkeys for controlling frame display, you can 
use keys on the keyboard. These keys are discussed in the section "Editing With The 
Keyboard Keys", in Chapter 1. 
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FINDING FRAMES (cont.) 

<Next Frame> 

<Previous Frame> 

<Scroll Frames> 

<Go To Frame #> 

softkey appears to move the displayed frames up one frame. 
What was the second frame being shown is now displayed at 
the top of the display. The next frame stored in the Receive 
Buffer memory is added to the bottom of the displayed 
frames. 

If <Next Frame> softkey is pressed while the last frame in 
memory being displayed, status message, No next frame., is 
displayed above the softkey selections. 

softkey appears to move the display down with a new frame 
added at the top. The new frame now seen at the top of the 
display is the frame in the Receive Buffer that precedes the 
previously displayed top frame. 

If <Previous Frame> softkey is pressed while the first frame in 
memory is being displayed, status message, No previous frame., 
is displayed above the softkey selections. 

Press <Scroll Frames> to cause the protocol analyzer to start 
incrementing the display through the frames stored in the 
Receive Buff er. 

Press <Stop Scrolling> or <EX IT> softkeys to end the scroll 
function, or, you can let the protocol analyzer automatically 
stop incrementing the display when the last frame in the 
Receive Buff er is displayed. 

No reverse scroll function is available. You can use <Go To 
Frame #> softkey to quickly move to previous frames or hold 
down the PREY keyboard key. 

lets you place a particular frame at the top of the display. 

Enter the frame number as an integer value such as; 3, 15, 
or 455. Non-integer entries will cause an error message to be 
displayed. Press the RETURN key to execute the command. 
(continued) 
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FINDING FRAMES (cont.) 

<Next Marked> 

<Previous Marked> 

<Scroll Marked> 

To quickly find and show the last frame in the Receive 
Buff er, enter a number you know is greater than the last 
frame number in the receive Buff er and press the RETURN 
key. 

Go to what frame #? 999999 

lets you update the display with the next following frame 
identified by a "Mark" to be displayed at the top of the screen. 

Frames can be marked manually by softkey selection as you 
scroll the frames or they can be marked by your program. 
Frames are marked to indicate a special filter condition or that 
they are of some particular interest to you. 

Using marked frames provides a quick method to scroll 
through the memory buffer to find only frames of interest to 
you. 

lets you update the display so that the closest previous frame 
identified with a "Mark" is displayed at the top of the screen. 

provides a method to get non-consecutive frames grouped 
together on the screen. 

Only marked frames are displayed. Unmarked frames 
occurring between marked frames are not displayed. 

After <Scroll Marked> function is selected, subsequent 
<Previous Marked> and <Next Marked> softkeys maintain this 
function of only displaying marked frames. Also, 
PREY /NEXT keyboard keys act like <Prev Marked> and 
<Next Marked> softkeys. 
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FINDING FRAMES (cont.) 

<Go To Trigger> 

<Mark/Unmark> 

causes the display to show the trigger frame identified in <Edit 
Programs> Menu for controlling the "Store" function: 

<Starting With> 

<Centered About> 

<Ending With> 

When one of these functions is used to control the "Store:" 
function, that trigger frame is displayed when the <Go To 
Trigger> sof tkey is pressed. 

This softkey toggles the mark condition either on or off. If no 
mark exists, the softkey marks the frame. If the frame is 
marked, press this sof tkey to remove the mark condition. 

<Mark> Puts a transparent mark on a single frame in the 
Receiver Buff er. When later examined in the buffer, 
marked frames can be selectively located and displayed. 

The frame currently at the top of the display is marked 
when you press the <Mark Frame> softkey. The frame 
number field is changed to inverse video to indicate a 
marked frame. 

<Unmark> Removes the frame "Mark" from the frame currently at 
the top of the display. 
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FINDING FRAMES (cont.) 

<Search Buffer> softkey lets you look through the buffer for a particular 
element(s) you have specified. Frame elements you may search 
for include: 

Destination Address 
Frames with errors 
Data Field Patterns (up to 6 bytes) 

Source Address 
Filters matched 

<Search Next> 
causes the protocol analyzer to look for the next frame in the 
buffer that contains the search elements you have defined. 

<Search Previous> 
causes the protocol analyzer to look for a frame stored 
previous to the currently displayed frame. The protocol 
analyzer looks for the search elements you have defined. 

<Define Search> 
softkey lets you identify or define the different frame 
elements you want to look for in the buffer. 

<Dest Address> 
lets you specify any message addressed to a specific 
node on the network. 

Enter the Hex code for the Destination Address you 
want to search for. Press RETURN key to complete 
the entry. 
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FINDING FRAMES (cont.) 

<Define Search> (cont.) 

<Source Address> 
lets you specify any message addressed from a specific 
node on the network. 

Enter the Hex code for the Source Address you want to 
search for. Press RETURN key to complete the entry. 

<Filter Matched> 
lets you see if a filter defined in the <Edit Filters> 
Menu can be matched to a frame stored in the receive 
buffer. 

Press <Filter Matched> softkey and then press the 
softkey that identifies the filter you want to use the 
next time you search the buff er. Press <EXIT> sof tkey 
to complete the entry. Choose a softkey to search 
forward (next) or backward (previous) in the buffer. 

<Error Frame> 
lets you search the buffer for frames that have a frame 
error. Press <Error Frame> and choose the error type 
you want to search for from the displayed softkeys. 
The frame error choices are: 

No Error 
Bad FCS 
Misalign 

Runt 
Jabber 
Any Error 

You can look for frames with a specific error, frames 
without any error, or only frames that have some type 
of error. 

Types of frame errors are described at the end of this 
chapter in the section, "Displaying Frame Errors." 
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FINDING FRAMES (cont.) 

<Datafield Pattern> 

1A·6E·XX·XX·XX-XX at offset 13 

54-68·69·73·20·69 at offset 15 

lets you search through the buff er for a frame with a 
specific data field pattern that starts at a byte offset 
you define. 

Press <Datafield Pattern> softkey and enter the pattern 
you want. The data field entry must be in Hex code. 
You can enter up to 6 characters. Don't care characters 
(XX) may be used in any of the positions. 

You must specify at what byte location in the frame 
you want to look for the characters. You can specify 
patterns starting from byte position l. 

Examples: 

Look for pattern 1A-6E in the 
TY PE/LENGTH field. 

Look for pattern 54-68-69-73-20-69 
at the first of the data field. 

starting 

16·16·16·XX·XX-XX at offset 214 Look for pattern 16-16-16-XX-XX-XX 
starting at the 200th byte in the data 

field. 

<Examine Data> Menu 19-16 



Selecting A Frame Display Format 

The format used to display frames stored in the Receive Buff er can be changed by 
using sof tkey selections. 

In addition, the entire group of counters and timers can be viewed on one display 
screen. 

The softkeys used to change the frame display format and display counters, and timers 
include: 

<Select Format> 

<Detailed Format> 

<Summary Format> 

<Filter Format> 

<Show Node Names> 

<Show Hex Addresses> 

<Counters & Timers> 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Select Format> 

<Detailed Format> 

<Summary Format> 

softkey provides another level of softkeys to let you group or 
display the frames in the following formats: 

Detailed format 

Summary Format 

Filter Format 

is the default format for displaying frame contents. <Detailed 
Format> displays the headers you have selected along with the 
data field of the frame. 

The default protocol for <Detailed Format> is Ethernet 
protocol. The default header display has <Physical Header> 
and <Ethernet Header> softkeys selected. The data field is 
displayed in combined <Hex and Char> format with <ASCII 
8> character code. 

An example of this softkey display is described in the previous 
pages under the "Default Display Description" heading. 

softkey lets you quickly get an overview of the messages 
received into the Receive Buffer. This display lets you view as 
many as eight messages at a time which enables you to easily 
recognize trends or patterns in the messages. The information 
displayed is: 

Frame number Calculated frame length 

Destination Address Filters matched 

Source Address Error indicators 
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SELECTING A FRAME DISPLAY FORMAT (cont.) 

<Summary Format> 
(cont.) 

With this display, you can get an overview of what stations 
are doing the transmitting and what stations are being 
transmitted to. 

FRAME DESTINATION SOURCE FRAME FILTERS ERRORS 
NUMBER ADDRESS ADDRESS LENGTH MATCHED 

. ... ... - ... --........... .................... . ... - ................. -............... 
01·23·45·67·89·AB FE·DC·BA·98·76·54 1267 Oxxx ••••...••••• No error 

2 08·00·09·FF·FF·FF 08·00·09-00·0A·08 342 01xx ..........•. No error 

3 OO·DD·OO·OD-08-00 08·00·09-00·0A-08 655 012x •...•....... No error 

4 08·00·09·00·0A·08 08·00·09·FF·FF·FF 1400 0123 ............ No error 

5 01·23-45-67-89-AB FE·DC·BA·98·76·54 67 Oxxx .......•.... Bad FCS 

6 01·23·45·67-89·AB FE·DC·BA-98·76·54 67 Oxxx ....•....... No error 

7 print_server CPU1 854 01xx ........•.•• No error 

8 mass store MAINCPU 1514 0123 .•..•.....•. No error -

Detailed Summary Filter Show Node Show Hex OTHER 
Names* Addresses CHOICES 

EXIT 
Format Format * Format 

Figure 19-2. <Summary Format> Softkey Display 

In the <Summary Format> display above, the Destination and Source Addresses are 
shown in hexadecimal format. If a node has been assigned a node name in the <Edit 
Nodelist> Menu, the assigned name is displayed. Frames #7 and #8 show the addresses 
displayed in functional node names which make it much easier to recognize address 
patterns in Destination and Source Addresses. 
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SELECTING A FRAME DISPLAY FORMAT (cont.) 

<Summary Format> 
(cont.) 

Frame lengths for the stored frames are displayed. 
The frame length field lets you recognize if only long frames 
are being transmitted or if any short frames occurred or if 
there is a mixture of long and short frames occurring. 

The "FILTERS MATCHED" Field makes it is easy to see 
what filters are being matched. This field shows currently 
defined filters and if a filter match occurs. In programs using 
several filters to trap or store the frames into memory, this 
display makes it easy to see what filters have been matched in 
a group of captured frames. 

The filter field function is described earlier in this chapter in 
the Default Display Description section. 

Different types of frames errors can occur during 
transmission. Having all the frames error status listed in a 
column makes it convenient to scroll the frames to look for 
frame errors. Types of frame errors that can be displayed are 
described in "Default Display Description" in this section. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> displays the headers you have selected, the fields of the filter 
you select, followed by the frame's data field. 

1 #1 

2 

The default filter format is the first filter matched. To select 
the filter for examining frames, press: 

<Select Format> 
<Filter Format> 
<OTHER CHOICES> 
<Change Filter> (Press filter softkey label) 

Filter fields of the filter you select are displayed above the 
data field. The first three fields of each filter are not 
displayed again since they are always Address and 
Type/Length fields. The first three filter field contents can be 
seen by selecting Ethernet or IEEE 802.3 header softkeys. 

Mar 9@ 6:10:34:55533 Len 61 Filters 0123 ............ No error 
Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 .!:iE! OA·OB 

3 data·filter1 30-30-30-31 0001 
4 

5 

6 

7 

15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D 
32 62·65·72·20·30·30·30·31·27·73·20·44·41·54·41·20·46 
49 49·45·4C·44·20·63·6F·6E·74·65·6E·74·2E 

This is Frame Num 
ber 0001's Data F 
ield contents. 

23 Detailed Summary Filter Show Node Show Hex OTHER EXIT 

24 Format Format Format* Names Addresses CHOICES 

Figure 19-3. <Filter Format> Display. 

In the example above, notice in line l that field "Filters: 
0123 ............ " indicates four filters have been defined and have 
been matched by frame #I. 

The details of the first filter matched in the frame are 
displayed below the header. Line 3 shows the field defined in 
Filter 0. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> 
(cont.) 

If the frame does not match any defined filter, message: 
"No filter matched" is displayed below the header lines. 

The example below illustrates a frame with <Filter Format> 
selected. In addition, other display format softkeys are 
selected. 

#1 

<Physical Header> 
<Ethernet Header> 
<802.2 Header> 
<Filter Format> 

displayed in line l 
displayed in line 2 
displayed in line 3 
displayed in lines 4-16 

Apr 1 @ 1:23:45.67890 Len 1514 Filters 01xx ............ No error 
2 

3 
4 
5 

6 

7 

8 
9 

Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 ~ OA·OB 
DSAP 54 SSAP 68 Control 69·73 

datafield 1 61·62 ab 
dataf ield 2 63·64 cd 
dataf ield 3 65·66·67·68 efgh 
dataf ield 4 
dataf ield 5 
dataf ield 6 

10 dataf ield 7 
dataf ield 8 11 

12 dataf ietd 9 
13 dataf ield 10 
14 datafield 11 

69·6A·6B·6C 
6D·6E·6F 
70·71 ·72·73·74 
75·76·77 
78·79·7A 
30·31·32·33·34 
35·36·37·38·39 
41·42-43-44-45-46·47·48 

15 dataf ield 12 49·4A·4B·4C 
16 dataf ield 13 4D·4E·4F 

i j kl 
mno 
pqrst 
uvw 
xyz 
01234 
56789 
ABCDEFGH 
IJKL 
MNO 

17 19 61·62·63·64·65·66·67·68·69·6A·6B·6C·6E·6F·70·71·72 
18 36 73·74·75·76·77·78·79·7A·30·31·32·33·34·35·36·37·38 
19 53 00-00·00·00·00·00·00·00·00· .... 

abcdefghijklmnop 
tuvwxyz123456789 
0000 ... 

20 
21 
22 
23 Detailed Summary Filter Show Node Show Hex OTHER EXIT 
24 Format Format Format* Names * Addresses CHOICES 

'------------------------------------------------------------------~ 
Figure 19-4. <Filter Format> With 13 Data Field filters. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

<Filter Format> 
(cont.) 

The previous example shows 13 filter fields and 3 lines of the 
Data Field. Since <Edit Filters> Menu lets you define up to 29 
filter fields in the Data Field, the Data Field contents may not 
be shown on the display. If 16 filter fields are defined, no line 
of data is displayed. To see past the 16th filter field and to see 
the Data Field, use the cursor keys to scroll the display. 

A label is displayed for each defined filter field. In addition, 
the characters located in each filter field are displayed in Hex 
along with the equivalent character. 

The equivalent character for the filter field is displayed in the 
last selection made between ASCII 7, ASCII 8, or EBCDIC. 
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SELECTING FRAME DISPLAY FORMAT (cont.) 

In each of the frame display formats, the Destination and Source Addresses can be 
displayed in either hexadecimal or as a functional node name. 

<Show Node 
Name> 

softkey displays any node address as a functional 
node name. 

The node name must be defined in the <Edit Nodelist> Menu. 
This softkey is available under the <Setup 497 lS> Menu. 

If the node name is not defined, the name is displayed in hex. 

An example of node names versus the Hexadecimal address is 
shown below: 

Hexadecimal 
Address 

08-AB-00·23-01-02 

66·CD·21·43·01·01 

08-AB-OO·XX·XX·XX 

Node 
Name 

Print_Server1 

JohnB 

al l_pr inters 

Notice that the node name can identify a device, the principal 
user at a nod~, or, by using a common prefix and don't cares 
(xx-xx), it can group nodes with common prefixes. 

<Show Hex Names> displays the node station as a six byte Hexadecimal address. 
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Selecting Frame Header Formats 

Each frame is displayed by the protocol analyzer with up to three headers. The first 
header is a physical header created by the protocol analyzer. The second header is the 
IEEE 802.3 or Ethernet header. The third header is for IEEE 802.2 protocol. 

The format used to display frame headers can be changed by softkeys. 

Softkeys used to control frame header formats include: 

<Change Headers> 

<Suppress Headers> 

<Physical Header> 

<Ethernet Header> 

<802.3 Header> 

<802.2 Header> 
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FRAME HEADER FORMATS (cont.) 

<Change Headers> softkey presents a softkey selection that is used to control the 
header display. 

<Suppress Headers> With <Suppress Headers> softkey selected, all physical headers 
and protocol headers are removed from each frame in the 
display. 

1 #1 

The example below shows a frame with all the headers 
removed. Lines l and 2 now contain the frame number and 
Data Field contents. The Destination Address, Source address, 
Length/Type, and Error fields are not displayed. 

2 15 54-68·69·73-20·69-73-20·46-72·61-6D-65·20-4E-75-6D 
3 32 62·65-72·20·30·30·30·31·27·73·20·44·41·54·41·20-46 
4 

5 

49 49-45·4C-44·20·63·6F-6E·74·65-6E·74·2E 

This is Frame Num 
ber 0001's Data F 
ield content. 

20 
21 
22 
23 Suppress Physical Ethernet 802.3 802.2 

Header 24 Headers* Header Header Header 

Figure 19-5. <Suppress Headers> Softkey Selection. 
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FRAME HEADER FORMATS (cont.) 

<Physical Header> The physical header contains information generated by the HP 
4971S about each frame stored in the Receive Buffer. 
Included in the physical header are: 

#1 

Time Stamp 
Calculated frame length 
Filters 
Errors 

Mar 9@ 6:10:34.55533 Len 61 Filters 0 ............... No error 
2 15 54-68-69-73·20·69-73-20-46-72-61-6D-65-20-4E-75-6D This is Frame Num 
3 32 62-65-72-20-30-30-30-31-27-73-20-44-41-54-41-20-46 ber 0001 1 s Data F 
4 

5 

6 

49 49-45-4C-44-20-63-6F-6E-74-65-6E-74-2E 

21 
22 
23 Suppress Physical Ethernet 802.3 
24 Headers Header* Header Header 

802.2 
Header 

ield content. 

Figure 19·6. <Physical Header> Softkey Selected. 

EXIT 

W'ith only <Physical Headers> header softkey selected, only the information added by 
the protocol analyzer is displayed. This header includes the physical description of the 
frame. Elements displayed are: Timestamp, calculated length of information fields, 
filters status, and error status. 
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SELECTING FRAME HEADER FORMATS (cont.) 

<Ethernet Header> 

<802.3 Header> 

The <Ethernet Header> softkey selects the Ethernet header for 
the display. This softkey is illustrated in figure 19-1. Ethernet 
displays use a "Type:" field for bytes 13 and 14. 

Ethernet displays also include the Destination Address and 
Source Address fields. 

IEEE 802.3 header is similar to Ethernet header, however, 
IEEE 802.3 uses a "Length:" field for bytes 13 and 14. 

<Ethernet Header> and <802.3 Header> softkeys toggle with each other. Selecting one 
cancels the other's display. Only one of these headers may be displayed at a time. 
Pressing the softkey that is active turns that function off and if the other header 
softkey is not pressed, neither header is displayed. 

#1 Destination 01·23·45-67·89-AB Source FE-DC·BA-99-76·54 Length OA·OB 
2 15 54-68-69·73-20·69-73·20-46·72·61·6D-65-20·4E·75·6D This is Frame Num 
3 32 62·65·72-20·30-30-30-31-27-73-20·44-41-54-41-20·46 ber 0001 1 s Data F 
4 

5 

21 
22 

49 49-45-4C-44-20-63-6F-6E·74·65·6E·74-2E 

23 Suppress Physical Ethernet 802.3 
24 Headers Header Header Header* 

802.2 
Header 

ietd content. 

Figure 19-7. <802.3 Header> Softkey Selection. 
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FRAME HEADER FORMATS (cont.) 

<802.2 Header> 

DSAP 

SSAP 

Control 

<802.2 Header> information is positioned in the first 3-4 bytes 
of the Data Field and contains the following information: 

DSAP (Destination Service Access Point) 
SSAP (Source Service Access Point) 
Control 

Byte 15 in the Data Field is labeled Destination Service Access 
Point address. This address references a specific protocol used 
within the device identified by the Destination Address. 
The DSAP field is displayed in hex. 

Byte 16 in the Data Field is labeled Source Service Access 
Point address. Similar to DSAP, this address references a 
specific protocol used within the device identified by the 
Source Address. 
The SSAP field is displayed in hex. 

The Control field, as it name implies, is used to control the 
communications between the processes or applications 
contained at the Destination and Source addresses. 

The Control field is also displayed in hex and may be either 
or 2 bytes. The 2 least significant bits of byte 17 determine if 
the protocol analyzer will display 1 or 2 bytes in the Control 
field. 

Byte 17 Byte 18 

MSB LSB MSB LSB 
xxxx xx 11 xxxx xxxx 

When the two least significant bits of byte 17 are l's, the 
protocol analyzer will display one byte for the Control Field. 
This determines whether the data field begins with byte 18 or 
19. 
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FRAME HEADER FORMATS (cont.) 

Control 
(cont.) 

Examples of control field contents include: 

Connection requested 
Connection accepted 
Connection denied 
Connection busy 

Confirmation of messages sent or received 

8 6 6 2 1- 2 46-1500 4 

1_1_1_1_._, 
Preamble Dest Source Type I I I Data FCS 

I I !_Control 

I l __ SSAP 

I DSAP 

The following example uses only the 802.2 header. Notice in the example below that 
the Control Field is two bytes and the Data Field starts at byte J 9. 

1 #1 
2 19 
3 36 

DSAP 54 SSAP 68 
20·69·73·20·46·72·61·6D·65·20·4E·75·6D·62·65·72·20 
30·30·30·31·27·73·20·44·41·54·41·20·46·49·45·4C·44 

4 
5 

53 20·63·6F·6E·74·65·6E·74·2E 

21 
22 
23 Suppress Physical Ethernet 802.3 
24 Headers Header Header Header 

802.2 
Header* 

Control 69-73 
is Frame Number 

0001 1 s Data Field 
content. 

EXIT 

Figure 19-8. <802.2 Header> Softkey Selection 
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Selecting Datafield Character Formats 

The information in the data fields can be presented in several formats. The data field 
can be suppressed from the display but is still available in the Receive Buffer. Also, the 
format of the data characters may be selected from a variety of choices. 

The softkey choices for data fields include: 

<Change Datafield> 

<Suppress Data> 

<Hex Data> 

<Character Data> 

<Hex/Char Data> 

<Select Data Code> 

<ASCII 7> 

<ASCll 8> 

<EBCDIC> 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Change 
Datafield> 

softkey changes the softkey selections to let you select 
different formats for characters in the data field. 

<Suppress Data> The entire data field can be suppressed or deleted from the 
display by pressing the <Suppress Data> softkey. Whatever 
data field had been displayed is now removed. If physical 
header, frame header, and data fields had been displayed, 
pressing <Suppress Data> leaves only the physical header and 
frame header displayed. 

2 
3 
4 

#1 

5 #2 

6 

20 
21 
22 
23 Suppress 
24 Data * 

In the example below, notice that only selected header 
information is displayed. 

Mar 9@ 6:10:34.55533 Len 
Destination 01·23·45·67·89-AB 
DSAP 54 

61 Filters 0 ............... No error 
Source FE·DC·BA-99·76·54 .!.i:E! 00·53 
SSAP 68 Control 69·73 

Mar 9 Ql 6:10:34.55533 Len 61 Filters 0 ............... No error 

Hex 
Data 

Character Hex/Char 
Data Data 

Select 
Data Code 

Figure 19-9. <Suppress Data> Softkey Selected. 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Hex/Char Data> 

<Hex Data> 
<Character Data> 

In the default <Examine Data> Menu, the data field is 
displayed below the header fields in two formats. The data is 
displayed in Hexadecimal format on the left side of the line 
with the interpreted data displayed on the right side of the 
same line. 

When <Character Data> or <Hex Data> softkeys are pressed, 
the data field is displayed only in that selected format. The 
equivalent data field is not displayed. 

These character formats are convenient since longer lines can 
be used to display the Data Field contents. <Character Data> 
formats display 73 characters per line while <Hex Data> 
format displays 24 characters per line. 

The example below shows the display with <Character Data> 
softkey selected. The data is presented only in the equivalent 
character format with no Hexadecimal equivalent display. 

1 #1 May 3 @12:21:03.24446 Len 167 Filters 1 ............... No error 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA·99-76·54 Length 00·53 
3 15 This is an example with <Character Data> softkey selected. Notice that 
4 88 no equivalent Hex characters are presented on the right side of the d 
5 161 isplay. 
6 

20 
21 
22 
23 Suppress 
24 Data 

Hex 
Data 

Character Hex/Char Select 
Data * Data Data Code 

Figure 19·1 o. <Character Data> Display. 
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DATAFIELD CHARACTER FORMATS (cont.) 

<Select Data 
Code> 

<ASCII 7> 

softkey lets you choose the character code. 
The choices are: 

<ASCII 7> 
<ASCII 8> 
<EBCDIC> 

The default display described in the section "<Examine Data> 
Display" at the first of this chapter is an example of the two 
column data format. The data is first presented in 
Hexadecimal code and then in the equivalent selected code of 
ASCII or EBCDIC. Seventeen characters are displayed in each 
line with either of these combined character protocols 
selected. 

ASCII 7 
No Par 

ASCII 7 
Par= 0 

ASCII 7 
Par= 1 

ASCII 7 
Odd Par 

ASCII 7 
Even Par 

The parity bit is ignored. 

The parity bit is always 0. 

The parity bit is always 1 

The parity bit is set to always provide an 
odd number of bits in the byte. 

The parity bit is set to always provide an 
even number of bits in the byte. 
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Displaying Data In Filter Formats 

You can display frames in the format of filters you have defined in <Edit Filters> 
Menu. Use the following softkeys to select the filter used to display frames: 

<Change Filter> 

<Select Format> 
<Filter Format> 
<OTHER CHOICES> 
<Change Filter> 

softkey displays softkey choices for the filters you have 
defined in <Edit Filters> Menu. 

The default filter format is the first filter matched. To select 
the filter format, press any displayed softkey containing a 
filter name. 

<Use first Matched> 

<Filter_O> 

<Filter 1> 

If you have several filters defined, <Use first Matched> 
softkey displays a frame in the filter format of the first 
filter to be matched by that frame. 

lets you manually change the frame display format to 
that of another filter even if the filter did not 
specifically match that data frame. 

Softkeys are displayed for each of the filters defined in 
the <Edit Filters> Menu. You can display any frame in 
the format of a defined filter. 
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Selecting Timestamp Measurements 

The HP 49715 can perform measurements that reference the time when frames were 
received into the protocol analyzer. When each frame is received into the HP 497 lS, 
each frame is tagged with the date and time. Measurements using this timestamp 
function can be made with 32 microsecond accuracy. 

The timestamp softkey functions detect the start and stop points of frames. Timestamp 
softkey descriptions use the following conventions for start and stop points of frames: 

Sta'1 of Frame 
refers to the beginning of the Destination Address Field in a frame. 

End of Frame 
refers to the end of the FCS Field in a frame. 

Examples of timing measurements that you can measure include: 

What date/time did the message occur on the network? 

How much time occurred from when the run is started to when each frame 
is received? 

How much time occurred between two specific frames being received? 

With some frame identified as a reference point, what is the time 
relationship of all frames received before or after the reference frame? 
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TIMESTAMP MEASUREMENTS (cont.) 

The softkeys used to make timestamp measurements include: 

<Change 
Time stamp> 

<Change Timestamp> 

<Date/Time> 

<Time from Start> 

<Time from Frame #> 

<Time from Trigger> 

<Time btwn Frames> 

soft key changes the softkey selection to display sof tkeys used 
for timestamp measurements. 

The protocol analyzer causes the date and time of day to be 
transparently added to each frame as it is received. This 
timestamp enables the following measurements: 

<Date/Time> 

<Time From Start> 

<Time from Frame #> 

<Time from Trigger> 

<Time btwn Frames> 

<Examine Data> Menu 19 .. 37 



TIMESTAMP MEASUREMENTS (cont.) 

<Date/Time> 

<Time from 
Start> 

is the default softkey for <Examine Data> Menu. It causes the 
timestamp field in each frame's physical header to display the 
date and time that each frame occurred on the network. 

The timestamp displayed in the physical header is referenced 
to the date and time you enter via the <Set Date> and <Set 
Time> softkevs at power on. 

The display format for <Date/Time> softkey is: month, day, 
hour, minute, second 

Mar 9 @ 6:10:34.55533 

In a free run or continuous store application, the timestamp 
functions for approximately 1.5 days. After 1.5 days of 
continuous storage, the protocol analyzer stop$ and displays 
the message: 

** Timestamp Overflow ** 

A new run must be started in order to start the timestamp 
function again. 

The clock is reset each time a run is started and is stopped 
when the run is stopped. 

causes the timestamp field in each frame's physical 
header to contain: 

The elapsed time measured from the run start to when 
each frame was received. 

Frames have an elapsed time entered in the field: 

Elapsed 00:00:01.67543 
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TIMESTAMP MEASUREMENTS (cont.) 

<Time From 
Frame#> 

<Time From 
Trigger> 

prompts you to identify a particular frame number 
and the timestamp is set to zero for that frame time. 

This softkey causes the timestamp field in each frame's 
physical header to display: 

The elapsed time from the start of the reference frame 
to the start of the displayed frame. 

Frames received before the reference frame have a (-) sign 
preceding the number to show negative time. 

In the following example, frame #3 has been selected as the 
reference frame: 

#1 Elapsed· 0:00:01.99978 

#2 Elapsed · 0:00:00.99987 

#3 Elapsed 0:00:00.00000 

#4 Elapsed 0.00.00.87241 

lets a frame matching a filter or combination of filters 
be specified as a trigger reference point. 

This soft.key causes the timestamp field in each frame's 
physical header to display: 

The elapsed time from the start of the trigger frame to the 
start of the displayed frame. 
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TIMESTAMP MEASUREMENTS (cont.) 

<Time From 
Trigger> 
(cont.) 

<Time btwn 
Frames> 

A trigger frame is the frame identified in <Edit Programs> 
to control the Store function: 

<Starting With> 

<Centered About> 

<Ending With> 

Only one of these functions can be used in each program. 
Whichever function is used, that frame is referenced to zero 
for <Time From Trigger> measurements. 

causes the timestamp field in each frame's physical header 
to display: 

The elapsed time from the end of the previous frame to 
the start of the next frame. 

The end of the previous frame is after the last byte of the FCS 
field. 

In <Time btwn Frames> mode, the timestamp in the first 
frame contains the time from the start of the run to the start 
of the first frame. 
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Selecting Timers And Counters 

In addition to displaying the contents of the captured frames, the <Examine Data> 
softkey lets you view the timers and counters available in programs you can create. 

<Timers & 
Counters> 

softkey displays the labels and contents of all 16 counters 
and all 16 timers. This display shows the contents of the 
counters and timers that existed when a program run was 
halted. To update or refresh the display, repeat a <Run From 
Network> or <Run From Buffer> function. 

When names have been assigned to either the timers or counters in <Edit Programs> 
Menu, the assigned names are also displayed in the <Examine Data> Menu. 

COUNTERS TIMERS 
.. .. .. .. "' -...... - .......... -- ......... .. - ........................ -- ..................... 

Counter 0 0 Timer 0 0.00 ms - -
Counter 1 = 0 Timer 1 = 0.00 ms - -
Counter 2 = 0 Timer 2 = 0.00 ms - -
Counter 3 0 Timer _3 0.00 ms -
Counter_4 = 0 Timer 4 0.00 ms 
Counter 5 = 0 Timer 5 = 0.00 ms - -
Counter_6 0 Timer_6 = 0.00 ms 
Counter 7 = 0 Timer 7 = 0.00 ms - -
Counter_8 = 0 Timer_8 = 0.00 ms 
Counter_9 = 0 Timer 9 0.00 ms 
Counter_A 0 Timer_A 0.00 ms 
Counter B = 0 Timer B 0.00 ms - -
Counter c = 0 Timer c = 0.00 ms - -
Counter D = 0 Timer_D 0.00 ms 
Counter_E = 0 Timer E 0.00 ms -
Counter F 0 Timer F = 0.00 ms -

Return EXIT 
To Data 

Figure 19-11. <Timers & Counters> Menu Display. 
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Displaying Frame Errors 

The HP 4971S LAN protocol analyzer displays several types of frame errors that may 
occur. This section reviews the IEEE 802.3 frame format and also describes the possible 
causes of frame errors that can be displayed. 

Frame Error Field 

" 1 #1 Mar 9@ 6.10.34.55533 Len 61 Filters 0 ............... Nd err~r 
2 Destination 01·23·45·67·89·AB Source FE·DC·BA·99·76·54 ~ OA·OB 
3 15 54·68·69·73·20·69·73·20·46·72·61·6D·65·20·4E·75·6D This is Frame Num 

IEEE 802.3 Frame Protocol 

The IEEE 802.3 standard specifies a message frame as: 

Dest Source Length/ 
Preamble Add rs Add rs Type Data Field FCS 

1_1 1 __ 1 
8 6 6 2 46 .. 1500 4 

I< .......•... Min length is 64 bytes . ............ ·I 
I I 
I< ........... Max Length is 1518 bytes ............. >I 

Minimum Maximum 
IEEE 802.3 IEEE 802.3 
Length Length 

6 Dest Addrs 6 
6 Source Addrs 6 
2 Length/Type 2 

46 Data field 1500 
4 FCS field 4 

64 bytes 1518 bytes 
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DISPLAYING FRAME ERRORS (cont.) 

IEEE 802.3 Preamble 

IEEE 802.3 specifies that the Preamble have a 64 bit synchronization pattern of alter­
nating l's and O's ending with two consecutive J's. The information immediately fol­
lowing the last synchronizing byte is grouped into the frame elements: Destination 
Address, Source Address Length/Type Field, Data Field, and FCS. 

In actual practice, preamble length can vary between different network systems. The 
<Hardware Functions> Menu lets you choose different preamble lengths of 16, 32, 64, 
or 128 bits for HP 497 lS transmissions. 

Types Of Frame Errors 

Several types of errors can be detected by the HP 497 lS and displayed in the <Examine 
Data> Menu. Definitions and possible causes of frame. errors are listed on the follow­
ing pages. 

Runt Frames 

Jabber Frames 

Misaligned Frames 

Corrupt Data Frames 

Bad CRC Frames 
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DISPLAYING FRAME ERRORS (cont.) 

RUNT FRAMES 

Definition 

Possible Causes 

A frame that is too short. It has less than the 60 bytes re­
quired by IEEE 802.3 for the Destination Address through 
Data fields. 

"Runt" frame label is displayed in the Error Field of the <Ex­
amine Data> Menu when frames have less than 60 bytes for 
Destination Address through Data fields. 

1. Frame collisions can cause Runt Frames. NormalJy, frame 
collisions occur very early in the frame transmission, well 
before the 512 bits needed before the protocol analyzer 
can receive the frame. 

2. The transmitting station sent a Data Field with less than 46 
bytes. 

3. Runt frames can also be caused by late collisions either 
because a node is not transmitting according to IEEE 802.3 
format or the network is physically too large. 
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DISPLAYING FRAME ERRORS (cont.) 

JABBER FRAMES 

Definition 

Possible Causes 

A frame that is too long; it has more than 1514 bytes in the 
information fields; Destination Address through Data fields. 

l. The transmitting station is not transmitting within specs. 

2. A MAU on the network has failed and is putting out 
garbage. 
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DISPLAYING FRAME ERRORS (cont.) 

MISALIGNED FRAME 

Definition 

Preamble 

Possible Causes 

A frame that has a total number of bits in the frame that is 
not divisible by 8 and also has a FCS error. 

The FCS error is usually caused by the uneven number of bits. 

Dest 
Add rs 

Source Type 
Addrs Field 

Data 
Field 

FCS 
(CRC) 

____ 1 •••• 

. I 
normal I 

FCS I 
position I 

I 
I 

FCS is assumed to be 
last 4 bytes on 
the frame. Ringing 
bits can cause the 
FCS to ~ to be 
displaced. 

1. Hardware impedance mismatch causes ringing on the 
network. 

2. The transmitting station may have sent the extra bits. 
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DISPLAYING FRAME ERRORS (cont.) 

CORRUPT DATA 

Definition 

Possible Causes 

Displayed when a possible error occurred in the message inside 
the protocol analyzer due to heavy network traffic conditions 
with frequent jabber frames occurring. 

1. Excessive number of jabber frames 

2. Hardware failure in the HP 497 lS. 
(Execute the Self-Test) 

<Examine Data> Menu 19·47 



DISPLAYING FRAME ERRORS (cont.) 

BAD FCS 

Definition 

Possible Causes 

Displayed when the FCS error check generated inside the HP 
497 lS does not match the FCS field transmitted by the Source 
Address. 

1. Ringing on end of message for exactly eight bits. 

2. Frame disturbed during transmission. 

3. The transmitter may be defective or have a bad MAU. 

4. Sy.stem noise due to improper grounding of network 
cable. 
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20 
< Printer Functions > MENU 

This chapter describes the softkeys used to control printer functions with the HP 497 IS 
system. 

This chapter includes: 

• <Printer Functions> Softkey Selections 

• Getting Top Of Forms 

• Stopping The Printer 

• Selecting The Printer 

• Printing The Node List 

• Printing Filters 

• Printing Messages 

• Printing Programs 

• Printing Data 

• Print The Screen 

• <Printer Functions> In Remote Mode 
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Printer 

< Printer Functions > Softkey Selections 

Functions 

Select 

Print 

Print 

Print 

Print 

Print 

Printer 

Nodes 

Filters 

Messages 

Programs 

Data 
Range of F ram1es 
Single Frame 
Marked Frames 
All Frames 
Print the List 

The <Printer Functions> Menu lets you have printed copies of received frames, the 
protocol analyzer's setup configuration and the current screen contents. 

You can print frames stored in the protocol analyzer's buffer memory. You are able to 
select and print only the frames that interest you. 

You can also print the protocol analyzer setup configuration. The setup configuration 
includes: 

Node list 

Filters 

Messages 

Programs 

ex; t Menu Finally, you can "print the screen" which includes all the characters shown on the HP 
497 IS display. 

<Printer Functions> Menu 20-2 



Getting Top Of Forms 

The HP 497 lS is intended to work with the HP 2225A ThinkJet Printer. 

The protocol analyzer controls the printer so that it prints 60 lines of text and then 
spaces 6 lines. If you position the top of the form correctly, you have 3 blank lines at 
the top of the form and 3 blank lines at the bottom of the form. 

Position the form 

You should set the top of the form to the fourth line on the page, to leave a top 
margin of 3 lines or l /2 inch. 

To set the top of the form to the fourth line: 

Use the Line Feed (LF) button to position the paper so that the page perforation 
is just above the pinch rollers. 

After the top of form is positioned, press the blue button on the control panel to 
reinitialize the printer. 

Experiment with positioning the paper for several printouts to determine the correct 
position for your application. 

The protocol analyzer does not sense the perforations on the forms; it continues to 
print 60 lines and space 6 lines. If you use the line feed button to advance the page, the 
text is not centered on the page. If you want to advance the page and maintain text 
centering, use the Form Feed (FF) button on the control panel. 
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Stopping The Printer 

As each request for printed copies is being printed, the message Printing is 
displayed. 

The print operation may take several minutes if long lists of frames, programs, filters, 
messages, or node lists are to be printed. 

You can stop the printer if you decide the list being printed is not what you want or it 
will take too long to print. While the list is being printed, the softkey <Abort 
Operation> is displayed. Press <Abort Operation> to stop the print function. 

<Abort Operation> softkey stops the printing operation after the current file in 
the printer buffer is printed. The protocol analyzer displays 
the message: 

Printer operation aborted by the user. 

The printer does not stop printing immediately after the 
<Abort Operation> softkey is pressed. Printing continues until 
current data stored in the printer buffer has been printed. The 
printer buffer can hold approximately one page of printed 
text. 
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<Select Printer> 

Selecting The Printer 

softkey causes the protocol analyzer to establish its link with 
the printer. If the link is successful, the protocol analyzer 
displays: 

Local Printer is selected and initialized. 

If the link is not successful, the protocol analyzer displays: 

THERE IS NO COMMUNICATION WITH THE PRINTER. 

If this occurs, check the following: 

1. Is the HP-IB cable connected? 

2. Is the printer's HP-IB switch set to address 1? 

If the switch has to be changed to 1, cycle the printer 
power switch off and back on. 

For information about <Select Printer> fur.11;;tions in 
Master/Slave operation, see <I/0 Functions> chapter. 
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<Print Nodes> 

Printing The Node List 

causes the printer to output a listing of the nodes identified in 
the <Edit Nodes> Menu. 

Up to 1000 nodes can be defined. Press <Print Nodes> softkey 
to begin printing the defined node list and display the message: 

Printing. 

Example of <Print Nodes>: 

NETWORK NAME : Network_O Network TYPE : ETHERNET 
NODE # NODE NAME NODE ADDRESS BUS POSITION 

HP LAN Analyzer 08-00·09-XX·XX·XX 0 

All the nodes defined in <Edit Nodes> Menu are printed. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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Printing Filters 

<Print Filters> causes the printer to print a listing of the filters defined in the 
<Setup 497 lS>, <Define Filters> softkey menus. 

If a fitter has been defined in <Edit Filters> Menu, all the 
details of that filter are printed when <Print Filters> softkey is 
executed. 

All of the 16 possible filters you create are printed. 

Press <Print Filters> softkey to begin printing the filters list 
and display: 

Printing. 

An example of <Print Filters> sof tkey is shown below: 

FILTER #0 Label: Filter_O MINIMUM Frame Length 51 
MAXIMUM Frame length = 2022 

BYTE 

7 
13 

15 

Frame Traits: REJECT Frame with GOOD FCS 
REJECT Frame with BAD FCS 
REJECT MISALIGNED Frame 
REJECT RUNT Frame 

FIELD LABEL FIELD DATA 

DESTINATION 
SOURCE 
TYPE 
DATA 

XX·XX·XX·XX·XX·XX 
XX·XX·XX·XX·XX·XX 
xx-xx 
xx 

Node Name: Not Defined 
Node Name: ·· Not Defined 

The printer inserts a ...... symbol before and after characters 
declared as "Not" characters in your filter definition. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 

<Printer Functions> Menu 20-7 



<Print Messages> 

MESSAGE 0 

Printing Messages 

causes the messages created in <Edit Messages> Menu to be 
printed. 

The protocol analyzer causes the printer to print all the 
messages you have created. Up to 16 user created messages are 
possible. 

Press <Print Messages> softkey to begin printing and display 
the message: 

Printing. 

An example of <Print Messages> follows: 

FCS VALUE: Good MESSAGE Label: MESSAGE_O 
FRAME Length: 60 Bytes 

BYTES FIELD LABEL HEX DATA 

1 ••••• 6 DESTINATION 
7 •••. 12 SOURCE 

00·00·00·00·00·00 Node Name: Not Defined 
08·00·09·00·0A·44 Node Name: HP LAN Analyzer 
00-00 
00·00·00·00-00-00·00·00·00·00·00·00-00·00·00 
00·00·00·00·00-00-00·00-00·00·00·00·00-00·00 

13 •.•• 14 TYPE 
15 .••. 29 DATA 
30 •••• 44 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Programs> 

Printing Programs 

softkey lets you print a selected program created in <Setup 
4971S>, <Edit Programs> Menus. Up to five programs can be 
created in the <Edit Programs> Menu. 

Press <Print Programs> softkey to display softkey choices for 
existing programs. Press a softkey for the program you want 
printed. 

The example below shows the default Program_O that is 
printed when you do not have a program of your own 
created: 

Usting of program 11 Program_0 11 

Store: all frames 
until full 

Log file: not used 

Block 1: 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Data> 

Printing Data 

softkey lets you get printouts of frames you have captured in 
the protocol analyzer's memory. 

You do not have to print a11 frames in the protocol analyzer 
memory. In order to save time and print only the frames you 
want, the protocol analyzer provides softkeys to choose whnt 
frames you want printed. 

Press <Print Data> softkey to display the following softkey 
choices for printing frames: 

<Range of Frames> 
<Single Frame> 
<Marked Frames> 
<All FrameS> 
<Print the List> 

Each frame chosen is printed in the format you currently have 
selected in the <Examine Data> Menu. 

<Print Data> softkey displays the following table for choosing 
what frames to print: 

FRAMES IN THE LIST (15 elements maximum) : 

1. 
2. 

15. 

You can select up to 15 combinations of; All Frames, Range 
of Frames, Marked Frames, and Single Frames to be printed. 
The same frame(s) may be printed in different groupings of 
frames. 

After you have selected all of the combinations that you want, 
press <Print the List> softkey. 
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<Print Data> (cont.) 

<Range of Frames> 
lets you choose a range of consecutively numbered frames to 
be printed. Press this softkey to display: 

FRAMES IN THE LIST {15 elements maximum) 

1. RANGE OF FRAMES FROM # ___ .....;..1 TO # 

Enter the f ifst frame number. 

From the keyboard, enter the first number of a range of 
frames you want printed. If you decide your range of frames 
entry is wrong, press CLEAR LINE or DELETE CHAR to 
clear the field. Enter the new number and press RETURN 
key to complete the entry. If you decide not to enter a range 
of frames, press <EXIT> softkey to delete that current element 
from the list. 

The protocol analyzer displays: Enter last frame number. 
Again from the keyboard, enter the last number for the range 
of frames you want printed. Press RETURN key to complete 
the entry. 

To quickly find the last frame number in the protocol 
analyzer's memory, enter 9999999 and press RETURN key. 
The protocol analyzer displays the last available frame. 

You may enter up to 15 different ranges of frames to be 
printed. 

After you have selected all the combinations that you want, 
press <Print the List> softkey to start printing and display: 
Printing. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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Print Data> (cont.) 

<Single Frame> 
softkey lets you print a single frame that is stored in the 
protocol analyzer's Receive Buffer. 

Press <Single Frame> softkey to display: 

FRAMES IN THE LIST (15 elements maximum) 

1. Single Frame # ___ _ 

2. 

Enter single frame number. 

From the keyboard, enter the frame number of the single 
frame you want printed. If you decide the Single Frame entry 
is wrong, press CLEAR LINE or DELETE CHAR keys to clear 
the field. Enter a new number and press RETURN key to 
complete the entry. 

Up to 15 separate frames can be printed using the <Single 
Frame> softkey selection. 

After you have selected all the frame combinations you want, 
press <Print The List> to start the printing and also display: 
Printing. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<Print Data> (cont.) 

<Marked Frames> 
softkey lets you print only the frames you have marked in the 
protocol analyzer's memory. 

In <Examine Data> Menu, you can manually mark frames that 
are of interest to you. Also, in <Edit Programs> Menu, you 
can create a program to mark particular frames as they are 
stored in the Receive Buffer. 

Press the <Marked Frames> softkey to display: 

FRAMES IN THE LIST C 15 elements maximum) 

1. MARKED FRAMES 
2. 

Press <Print the List> softkey to begin printing marked frames 
in the Receive Buffer and display the message: Printing. 

If you enter <Marked Frames> more than once, you repeat 
printing a marked frame list as many times as you entered the 
softkey. 

If no frames have been marked in the Receive Buffer, the 
protocol analyzer returns to the <Print Data> Menu and 
displays the message: 

NO MARKED FRAMES IN BUFFER. 

Press <Abort Operation> softkey to stop printing marked 
frames before the complete list is printed. See <Abort 
Operation> description on page 20-4. 
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<Print Data> (cont.) 

YES 

<All Frames> 
softkey lets you print all frames currently stored in the 
protocol analyzer's memory. Press <All Frames> softkey to 
display: 

FRAMES IN THE LIST (15 elements max;mum) : 

1. ALL FRAMES 
2. 

After you have selected all the frame combinations you want, 
press <Print The List> to start the printing and also display: 
printing. 

Press <Abort Operations> softkey to stop printing before the 
complete list is printed. See <Abort Operation> on page 20-4. 

<Print The List> 
softkey is the execute key for <Print Data>. Press <Print the 
List> soft.key to begin printing whatever group of frames you 
have selected. The protocol analyzer prompts: 

Would you like to print the timers and counters also? 

NO EXIT 

Press <YES> softkey if you want to print tue data list and the 
timers and counters list. 

Press <NO> softkey if you only want to print the data list. 

Press <Abort Operation> softkey to stop printing before the 
complete list is printed. See <Abort Operation> description on 
page 20-4. 
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<EXIT> softkey lets you delete a current element you are defining in 
the list. 

When the <Range of Frames> or <Single Frame> softkeys are 
currently selected, you can press <EXIT> to delete that 
element from the list and then make another softkey selection 
to add another frame combination to the list. 

WARNING 

If you press <EXIT> with no Range of Frames or Single 
Frame entry field currently active for entry, the protocol 
analyzer deletes the entire frame list. 
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Print The Screen 

The HP 497 lS has an additional important printer function. You can print the current 
screen display simply by pressing SHIFT and PRINT keys at the same time. 

These keys can be used whenever you are in any menu except <Printer Functions>. 

This function lets you conveniently print a hard copy of whatever function you are 
editing or frames you may be viewing at that moment. 
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< Printer Functions > In Remote Mode 

When two protocol analyzers are used for remote operation and each location has a 
printer, you can get printouts at either the slave location or the master location. 

Selecting The Printer In Remote Mode 

After the remote link is established, use the following procedure to select the printer 
location. 

1. Press <Select Printer> softkey. 

2. HP 497 lS prompts: Select the MASTER or SLAVE. 

3. Press either the <MASTER> or <SLAVE> softkey for the printer location you 
want to use.I 

4. 

If a printer location is not specified, the system defaults to the slave printer when 
the remote link is established. 

HP 497 lS displays: ____ printer is selected. 
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21 
< Hardware Functions > Menu 

This chapter describes the menus and softkeys used to display the hardware 
configuration of the HP 4971A and to test hardware circuitry in the HP 4971A 
instrument. 

A self test is performed automatically at power on. The power-on self test is a subset 
of the self tests available in the <Test LAN Analyzer> Menu. 

The <Test LAN Analyzer> softkey lets you run the more extensive self tests. 

This chapter includes: 

• HP 4971A Hardware Functions Display 

• HP 497 LA Hardware Functions Descriptions 

• <Test LAN Analyzer> Self Tests 

• Running The Self Tests 
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HP 4971A Hardware Functions Display 

From the Top Level Menu, press the <Hardware Functions> softkey to display the 
menu shown below. 

LAN Address of this Analyzer: 08-00·09·00·1A·34 

Memory bytes available: XXXXXX (varies with system usage) 

LAN Receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 
Shallow Trapmachine hardware: 

Runt Frame filter: 

Receiver Buffer size: 

Transmitter preamble length: 

Execute Network File at power-on: 
Network file name: 

Installed 
Installed 
Installed 
Installed 
Installed 

enabled 

1SOO bytes 

M bits 

Yes 
AUTOEX 

Test LAN 
Ana l_yzer 

Enabled Disabled 
(Normal) 

Figure 21-1. <Hardware Functions> Menu. 
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HP 4971A Hardware Functions Description 

LAN Address of this Analyzer: 
This line displays the IEEE 802.3 address unique to your HP 
497 lS. This is the six byte address used in default Source and 
Destination Address fields of IEEE 802.3 and Ethernet 
protocols. 

Memory bytes available: 
shows how many bytes of RAM memory are available for use 
by the HP 497 lS. This is the memory space used for protocol 
analyzer functions such as editing the node list, programs, 
filters, and messages. The available memory display is updated 
dynamically during operation of the analyzer. 

LAN Receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 
Shallow Trapmachlne hardware: 

These are the hardware printed circuit boards that are used to 
perform the protocol analyzer functions of the HP 497 lS. All 
of these boards must be installed for the protocol analyzer self 
test to pass and for the protocol analyzer to function. 

<Hardware Functions> Menu 21 ·3 



Runt Frame filter. lets you choose the minimum frame length for the protocol 
analyzer to accept. 

It is common for frames shorter than the IEEE 802.3 require­
ment to occur on the network due to collisions. 

The HP 4971S can capture frames shorter than the IEEE 802.3 minimum length. You 
can choose between two minimum sizes of Runt frames to be captured. You can store 
frames with information fields as short as: 

Approx. 52 bytes ·· with Runt Frame Filter: Enabled 
( 38 bytes in the data field ) 

15 bytes ·· with Runt Frame Filter: Disabled 
( 1 byte in the data field ) 

IEEE 802.3 specifies that the minimum frame length should be 64 bytes from Destina­
tion Address through the FCS Field (60 bytes in Dest. Addrs, Source Addrs, Type/ 
Length, and Data Fields). 

Dest. 
Preamble Addrs 

Source 
Add rs 

Length/ 
Typ·e Data Field 

FCS 
(CRC) 

----- ---- ____ ! __ !_______ -------- ____ I 
8 6 6 2 46-1500 4 I 

I 
l<······IEEE 802.3 specifies minimum length as 64 bytes -----... -.. -. >I 
I 
I 
I<· ---

I 
I 

60 bytes (Data Field = 46 bytes ) -- .. -->I 
These fields are referred to as "Information Fields" 
in this manual. 
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Runt Frame Filter: (cont.) 

Enabled 

Disabled 

In default mode, the Runt frame filter is enabled. The 
protocol analyzer discards frames with less than approx. 52 
bytes in the information fields ( at least 38 bytes in the data 
field). 

Very short frames can cause problems in HP 4971S hardware 
used to capture frames. In "Enabled" mode, the HP 497 lS 
avoids the hardware problems by discarding the frames with 
less than 52 bytes in the information fields. 

The "Disabled" mode is provided for unique or specific 
applications when you need to capture and view very short 
frame fragments. You should return to the "Enabled" mode 
when you are finished with your special measurement. 
"Enabled" mode provides complete integrity for received data. 

In "Disabled" mode, the protocol analyzer can store frames 
with as few as 15 bytes in the information fields (at least one 
byte in the Data Field). 

WARNING 

In "Disabled:" mode, hardware filters and data frames stored 
in the HP 4971$ can be corrupted. Data frames can also be 
missed. Use "Runt Frame Filter. Enabled" mode for normal 
operation. 

The error message, "CORRUPT DATA", is displayed in the 
<Examine Data> Menu if an error occurs in a frame while it is 
being received inside the analyzer. When short frames occur, 
HP 497 LS filters start being loaded, however, if the frame is 
discarded, the filter is not reset until the next complete frame 
is received. Until the next complete frame is received, 
received data frames can be corrupted, frame fragments can 
be missed without an error message displayed. 
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Receive buffer 
size: 

480 bytes 

lets you select the length of buffer used to store frames 
received from the network. 

The "480 bytes" mode is provided for unique or specific 
applications when you need to capture more than 655 frames 
in the HP 4971S receive buffer. We recommend you return to 
the "1500 bytes" mode when you are finished with your special 
measurement. 

During normal, low traffic (Less than 10-20<Yo) monitoring, if 
your network generally transmits shorter length frames, you 
can store more frames in memory by setting the buff er length 
to 480 bytes. 

WARNING 

When operated In "480 bytes" mode, data integrity problems 
can occur under high network loads. The following llst 
shows the two possible conditions when data Integrity 
problems can occur. 

1500 bytes 

1. During heavy network loads, when frame lengths slightly 
greater than 480 bytes occur, an extra character may be 
added to the frame by the protocol analyzer. When this 
happens, the frame is marked as "CORRUPT DAT A" in 
the <Examine Data> Menu. 

2. When frames are received with mm1mum interframe 
spacing, (9.6 us), there is a slight possibility that one of the 
frames or both frames may be corrupted by the protocol 
analyzer. lf a frame is corrupted, it is marked as 
"CORRUPT DATA". 

is the default length. Use this buffer size when you do not 
want to risk missing a frame in the protocol analyzer. 

1500 byte buff er length lets all frames passing the runt frame 
filter be stored without the risk of corrupt buffers. 
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The number of frames that can be stored in the HP 49715 receive buffer depend on 
two conditions: 

STORE METHOD USED RECEIVE BUFFER LENGTH 

Linear Storage 
Until Full 
Starting With 

Circular Storage 
Centered About 
Ending With 
Nonstop 

480 byte buff er 
1500 byte buff er 

480 BYTE BUFFER LENGTH 
LINEAR STORAGE CIRCULAR STORAGE 

1 

2046 FRAMES MAX 

CIRCULAR 
OVERHEAD~ 

1500 BYTE BUFFER LENGTH 
LINEAR STORAGE 

1 

655 FRAMES MAX 

CIRCULAR STORAGE 

NEWEST FRAME ~ 

CIRCULAR 
OVERHEAD~ 

Figure 21-2. Receive Buffer Storage. 
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Transmitter 
preamble 
length: 

Execute Network 
Fiie 

at power-on: 

Network file name: 

You can change the length of the preamble for messages 
transmitted the HP 4971S. Using different preamble 
lengths lets you test receive functions of stations on your 
network, for preamble length are: 

16 bits 
32 bits 
64 bits 
128 bits 

The HP 497lS can not receive frames with only 16 bits in the 

lets you choose whether or not you want to automatically 
execute a network file when the protocol analyzer is turned 
on. You can create network files that automatically loads a 
program and menus to perform tests you specify. 

See chapter, <Disc Functions> Menu, for more information 
about creating and saving network files. 

lets you choose the network file that is to be automatically 
loaded at power on. A default network file name, AUTOEX 
(AUTO EXecute), is used by the HP 497 lS. 

If you want to automatically load a file name other than 
A UTOEX, enter the new file name and then press RETURN 
key to complete the entry. 
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< Test LAN Analyzer > Self Tests 

A brief description of tests performed by the <Test LAN Analyzer> softkey is listed on 
the following pages. This section gives you an overview of the self tests performed on 
the HP 497 lA instrument. A more detailed description is given in the HP 497 lS 
Hard ware Support Manual. 

Hardware boards test status 

The hardware list displayed for <Hardware Functions> Menu shows the status of 
boards after the power-on self test or <Test All Hardware> test is completed. If any 
board fails, the display indicates which board(s) failed. 

LAN receiver hardware: 
LAN Transmitter hardware: 
Dual Port RAM hardware: 
Deep Trapmachine hardware: 

INSTALLED 
INSTALLED 
INSTALLED <· FAILED HARDWARE TEST 
INSTALLED 

Shallow Trapmachine hardware: INSTALLED 

Loss of stored messages and data. 

After you select the <Test Hardware> softkey, a message is displayed to warn you that 
when the self test is performed, any setup menu information, and transmit and receive 
buffer data is lost. Internal memory is used during the hardware tests and any stored 
information is written over. 
The hardware tests give a high degree of assurance that the hardware of the protocol 
analyzer, the Access Unit Interface (AUI) cable, and the Media Access Unit (MAU) are 
working correctly. 

When you run the <Test All Hardware> and <Network Loop Test> softkey tests, you 
have run a very extensive test of the protocol analyzer and its link to the local area 
network (LAN). 

Test LAN Analyzer 
Test ALL Hardware 
Network Loop Test 
Reset MAU 
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<Test All 
Hardware> 

<Network Loop 

Test> 

<Reset MAU> 

softkey runs a self test without having to go through 
the power-on software loading routine. The <Test All 
Hardware> softkey tests the buffer memory more extensively 
than the power-on test. 

Functions tested by this softkey include: 

LAN Receiver 
LAN Transmitter 
Dual Port RAM 

Deep Trap Machine 
Shallow Trap Machine 
Internal Loopback 

After running the <Test All Hardware>self test, if your system 
is connected to a LAN, you may want to perform the 
<Network Loop Test> to also verify that the AUi cable, MAU, 
and the network are functioning. 
softkey causes the protocol analyzer to transmit two frames on 
the network. 
The frames pass through the AUi cable, through the MAU, 
onto the network cable, and then back to the protocol 
analyzer. 

If the received frames are the same as the transmitted frames. 
you have verified operation of the transmit/receive circuitry 
in the protocol analyzer, the AUi cable, the MAU and the fact 
that the network cable is functioning. 

The protocol analyzer resets or initializes the MAU by 
disconnecting the MA U's power for about one second. 
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Running the Self Tests 

When you elect to run the self tests, the protocol analyzer displays status messages 
during the test and at the end of the test. 

During the test. 

During the test, the protocol analyzer displays: 

Testing ( test name ). 

After the test. 

Depending on whether the test passes or fails, the protocol analyzer displays one of the 
messages: 

Pass Name of hardware board: INSTALLED 

Failed Name of hardware board: INSTALLED <- FAILED HARDWARE TEST 

If the test fails. 

Refer to the HP 4971S Hardware Support Manual for trouble shooting information if 
any test fails or, contact your nearest HP Service Office. 
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22 
< Passwords > MENU 

This chapter describes the password features used to control access to HP 497 lS 
Receiver and Transmitter functions. 

This chapter includes: 

• <Passwords> Sof tkey Selections 

• Introduction 

• Changing The Password 

• Storing The Password 

• Securing Receiver Or Transmitter Functions 

• Unsecuring Receiver Or Transmitter Functions 

• Passwords In Other Analyzer Menus 
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< Passwords > SOFTKEY SELECTIONS 

Passwords 

Enter Rev Password 

Secure Receiver 

Enter Xmt Password 

Secure Xmitter 

Change Password 
New Rev Password 

New Xmt Password 

Store New Password 

EXIT 
EXIT 

<Passwords> Menu 22-2 

WARNING 

The <Passwords> feature works. There is no procedure to 
recover a forgotten password from the protocol analyzer. If 
you forget your password, you must reboot your system 
using the original software supplied with your protocol 
analyzer. 

When a password is saved to the Configuration File, no 
procedure exists to recover the password from the file. 

You should keep a copy of the original software (without 
passwords) in a secure place. Store passwords only on 
working copies of your system software. Another 
suggestion is to record your password on paper and store 
the paper in a secure location. 



Introduction 

<Password> Menu lets you disable or block certain f ea tu res of the HP 497 lS. Two 
primary functions of the protocol analyzer that are disabled by passwords are: 

l. Displaying the data field portion of captured frames. 

2. Sending messages from the protocol analyzer. 

In the <Passwords> Menu, you can suppress displaying the data field portion of 
captured frames. IEEE 802.3/Ethernet headers as well as the HP 497 lS physical headers 
containing frame length and error information can be viewed for network trouble 
shooting. With the password feature enabled, only authorized operators may view 
confidential messages. 

<Passwords> can prevent the HP 497 lS from transmitting messages onto the network. 
Only authorized operators may send frames with the password function enabled. 

NULL Password 

In default mode, that is, no user password has yet been entered. the Receiver and 
Transmitter passwords are both NULL passwords, (all <BLANK> characters). 

The NULL password lets you have full access to reading frame data fields and sending 
messages on the netw9rk. 

Secured Operation 

To secure (disable) either the Receive or Transmit functions. you must define and enter 
a password into the protocol analyzer. 

You can use different passwords to secure the Transmit and Receive functions 
separately, or. if the Receive and Transmit passwords are the same, your password needs 
to be entered only once. 

Saving A Password 

A password can be saved to the Configuration File to cause the protocol analyzer to 
power up in a secured mode each time the power is cycled to ON. 

<Passwords> Menu 22·3 



Using passwords involves the operations: 

l. Changing a password. 

2. Storing a password. 

3. Securing the receiver and/or the transmitter functions. 

4. Unsecuring the receiver and/or transmitter functions. 

Each of these operations are discussed on the following pages. 

PRACTICE PRACTICE PRACTICE PRACTICE PRACTICE 

You should practice using the password softkeys until you are sure you understand the 
password menu. Use a single character such as "l" or "A" for the password entry. As 
you change or edit the passwords, increment the character to the next value "2" or "B". 

If you forget the password or get confused, it is much quicker and easier to enter single 
characters until you find the password. 

When you are comfortable with the procedures for passwords, then enter longer and 
more complex passwords ( up to eight keyboard characters). 
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Changing The Password 

In default mode, the Receiver and Transmitter passwords are both NULL (all <SPACE> 
characters). To secure the Receiver and/or Transmitter functions, use the <Change 
Password> softkey. 

If another password has been entered, the <Change Password> menu also lets you 
revoke the previous password and enter a new password. 

Enter Rev Secure Enter Xmt Secure Change EXIT 
Password Receiver Password Xmitter Password 

~ 

New Rev New Xmt Store New EXIT 
Password Password Password 

<Change Password> This softkey presents a display to let you enter new passwords. 
The new password can replace the NULL password or, it can 
replace a previously defined password. 

Press <Change Password> softkey to display: 

<Enter New Rev Password> 

Enter Rev 
Password 

Enter Xmt 
Password 

Store New 
Password . 

opens the protocol analyzer to accept a new password for 
Receiver functions. 

<Enter New Xmt Password> 
opens the protocol analyzer to accept a new password for 
Transmitter functions. 
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PROCEDURE TO CHANGE PASSWORDS 

1. From the <Passwords> Menu, press <Change Password> softkey. 

2. Which password do you want to change? Choose one of the following. 

Press <New Rev Password> to change the Receiver password. 

Press <New Xmt Password> to change the Transmitter password. 

3. A. Current password is NULL 

a. 497 lS prompts: Enter your NEW password. C0 •• 8 characters) 

b. Enter up to 8 keyboard characters and press the RETURN key. 

c. 4971 S prompts: Please verify your new password by retyping it. 

d. Enter the new password again and press the RETURN key. 

e. 4971 S displays: Secured (Enter password for access) 
Password changed 

B. Current password is not NULL 

a. 497 lS prompts: Enter your CURRENT password. (0 .. 8 characters) 

b. Enter your current password and press the RETURN key. 

If you enter the wrong password, the HP 4971S prompts: 
INCORRECT PASSWORD 

After you correctly enter the CURRENT password, 

497 lS prompts: Enter. your NEW password. (0 .. 8 characters> 

<Passwords> Menu 22·6 



c. Enter up to 8 keyboard characters and press the RETURN key. 

d. 497 IS prompts: Please verify your new password by retyping it. 

e. Enter the new password again and press the RETURN key. 

f. 497 IS displays: Password changed 
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Storing The Password 

After a password is changed, you can use the new password to secure Receiver and 
Transmitter functions temporarily or until the power is turned off, 

In order to automatically restore the same password when the power is turned on again, 
you must store or save the password to the Configuration File, CNFG. 

<Store New Password> 
overwrites the new password over the current password on the 
Configuration File, CNFG. 

The Configuration File is located on the LANCOD system 
disc. When you store the password, the protocol analyzer 
looks for the LANCOD disc. The analyzer prompts you to 
install LANCOD if it is not found. 

In systems using only the HP 91220 Dual Disc Drive, you must 
install the LANCOD disc in a disc drive slot. In systems with 
system software loaded on a Winchester disc drive, the 
analyzer finds the LANCOD volume on the hard disc. If two 
LANCOD volumes are found, the analyzer stores the password 
on the volume with the lowest unit number. Floppy disc 
volumes always have a lower number than hard disc volumes. 

<Store New Password> overwrites a new password over a 
previously defined password without disturbing any other 
elements on the configuration file. 

WARNING 

If you define a new password and use the <Save Config.> 
softkey, you overwrite the entire configuration file not just 
the old password. 

Use <Store New Password> when you want to change only 
the password on the configuration file. 
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Securing Receiver Or Transmitter Functions 

You can cause the Receiver and/or Transmitter function to become secured by 
changing to a new password. 

Also. you can use the current password and secure the Receiver and/or Transmitter 
functions with the softkeys <Secure Receiver> and <Secure Transmitter>. 

<Secure Receiver> 

<Secure Xmitter> 

This softkey lets you disable the Receiver function. You can 
not view data fields in any frames received from the network. 

To unsecure or enable the Receiver function, you must press 
the <Enter Rev Password> softkey and enter the current 
password or change the password with <Change Password> 
softkey. 

This softkey lets you disable the Transmitter function. You 
can not transmit frames from the protocol analyzer onto the 
network. 

To unsecure or enable the Transmitter function, you must 
press the <Enter Xmt Password> sof tkey and enter the current 
password or· change the password with <Change Password> 
softkey. 
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Unsecuring Receiver Or Transmitter Functions 

There are two methods to unsecure or remove a password from the Receiver or 
Transmitter functions while you are in the <Passwords> Menu. 

1. Change an existing password to a new name by using the <Change Password> 
softkey. See the section "Changing The Password" in this chapter. 

2. Use the <Enter Rev Password> or <Enter Xmt Password> softkeys to enter the 
current password. 

<Enter Rev Password> 

<Enter Xmt Password> 

Press this softkey and then enter the current Receiver 
password. Press the RETURN key. 

If you correctly enter the password, the HP 497 lS displays: 

Unsecured (Password has been entered) 

Press this softkey and then enter the current Transmitter 
password. Press the RETURN key. 

If you correctly entered the password, the HP 497 lS displays: 

Unsecured (Password has been entered ) 
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Passwords In Other Analyzer Menus 

If a password is used to secure Receive or Transmit functions, the following analyzer 
menus display an error message when you try to view a frame's data field or send a 
message. 

<Edit Filters> Menu 

<Edit Messages> Menu 

<Edit Programs> Menu 

<Examine Data> Menu 

<Printer Functions> Menu 

Receiver Functions 

When a Receiver password is active, the data field portion of received frames is not 
displayed in any analyzer menu. Only the physical header generated by the analyzer 
and the IEEE 802.3/Ethernet headers can be displayed. 

The data field information for each frame is in the protocol analyzer's receive buffer. 
To view the data fields, you must unsecure the Receiver function password. 

Transmitter Functions 

In <Execute Programs> Menu, 'when a Transmitter password is active and a <Send 
Message> command occurs, no message is sent. 

An error message is displayed to alert you that the protocol analyzer can not send 
messages until the Transmitter function password is unsecured. 
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23 
< Set Date > AND < Set Time > MENUS 

This chapter describes how to set the date and time for your protocol analyzer. 

At power up, or any time the power to the HP 4971 A system has been interrupted, the 
date and time should be set. It is important to set date and time so that disc functions 
and time measurement functions that reference the time are accurate. 

This chapter includes: 

• Setting The Date 

• Setting the Time 
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Setting The Date 

PROCEDURE: 

1. From the Top Level Menu, press the <OTHER CHOICES> softkey to 
display softkeys for setting the date and time. 

2. Press <Set Date> softkey. 

Entry format 

The date entry must follow the format: 

day month year 

For example: 

15 jan 87 

Entry values 

(separate each entry with n space) 
(use three letters for month) 

January 15, 1987 

The values you can enter for the day and year must be within the range 
listed below: 

years= => 0 
=< 99 

days= 

3. Press the RETURN key to complete the entry. 

=> l 
=< 31 
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Setting The Time 

PROCEDURE: 

1. From the Top Level Menu, press the <Set Time> softkey. 

Entry format 

2. The time entry must follow the format: 

hour:minute:second (separate each entry with a colon :) 
(use 24 hour entry to denote AM and PM) 

For example: 

9:30:00 = 9:30 AM 

21:30:00 9:30 PM 

Entry values 

The values you enter for the hours, minutes, and seconds must be within the 
ranges listed below: 

hours = => 0 
=< 23 

minutes => 0 
=< 59 

seconds => 0 
=< 59 

3. Press the RETURN key to complete the entry. 
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INDEX 

This index references both volumes of the HP 497 IS Operating Manual. 

Volume! contains chapters 1 through 8, Appendices A-D and a glossary 
Volume II contains chapters 9 through 23 
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10BASE2 
10BASE5 
1500 byte buffer 
480 byte buff er 

<802.2 Format> 
<802.2 Header> 
<802.3 Format> 
<802.3 Header> 
802.3 Frame Protocol 

<Abort Operation> 
Accessories for the HP 497 J A 
Accessories for the HP 497 lS 
Accessory boards, locations 
Access Unit Interface (AUI) 

Active sof tkeys 
<Add Filter> 
<Add Message> 
Address, HP 4971S LAN address 
Address switches, memory boards 
<All Frames> 

Altitude 
<And> 
<And Frame Traits> 
<And Then> 
<Append Nodes> 

ARROW-DOWN key 
ARROW-HOME key 
ARROW-LEFT key 
ARROW-RIGHT key 
ARROW-UP key 

<ASCII 7> 
<ASCH 8/Roman 8> 
ASCII code tables 

A 

6-21, 6-22 
6-14, 6-22 

21-6 
21-6 

12-18 
19-29 
12-17 
19-28 
6-17 

20-4 
2-12 

2-9 
4-32 
6-14 

1-10 
12-10 

13-4 
21-3 
4-34 

14-7, 18-13 

2-7, 3-2 
14-43 

14-14, 14-44 
14-31 
18-15 

1-11 
1-11 
1-11 
1-12 
1-12 

12-16, 13-6, 19-34 
12-16, 19-34 
Appendix B 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Assigning A Printer 
Assigning The Mass Storage Device: 

Backing up system software 
BACKSPACE key 
Bad FCS 
Baseband 
Baud Rate: 
<Beep> 

<Binary LSB Left> 
<Binary LSB Right> 
<Bin LSB Left> 
<Bin LSB Right> 

Bits/Character: 
<Block l> 
Block structure 
Buff er Memory 

Bus position 
Bus Topology 

B 

Byte position in <Examine Data> Menu 

<Capture Slave> 
Carrier Sense 
<Centered About> 
<Change Data field> 
<Change Filter> 

<Change Headers> 
<Change Password> 
<Change Timestamp> 
<Character Data> 
Character entry 
CLEAR LINE key 
Coaxial Cable 

c 

20-5 
15-13 

5-17 
l-15 

19-5, 19-48 
6-14 
15-4 

14-37 

11-11 
IJ-10 
12-16 
12-16 

15-6 
14-14 
14-24 

7-4 

11-6 
6-10 
19-6 

15-13 
6-15 

14-l l 
19-32 
19-35 

19-26 
22-5 

19-37 
19-33 

l-16 
1-12 
6-11 

Vol~me I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Collision 
<Collision Counter> 
Collision Detect 
Collision LED 
<Compress Volume> 
Configuration file 
Control field (IEEE 802.2) 

<Copy Block> 
<Copy Files> 
Copy Files Syntax 
<Copy Filter> 
<Copy Frame> 
Copying <All Files> 
Copying <Analyzer Files> 
Copying <Unique Files> 

<Copy Message> 
<Copy Program> 
Copy system software 
Corrupt Data 
<Counters & Timers> 

<Create New File> 
CSMA 
CS MA/CD 

<Datafield = 0000 ... > 
<Datafield = 0101 ... > 
<Datafield = 1010 ... > 
<Datafield = 11 l l ... > 
Data Field, IEEE 802.3, Ethernet 
<Data Field Pattern> 

<Data File> 
Date (Setting The Date) 
<Date/Time> 
DDCMP: 
DDCMP Buff er size:· 

D 

12-21 
14-29, 14-4 7 

6-15 
16-8, 17-6 

18-27 
18-8 

19-29 

14-38 
18-16 
18-22 
12-19 

13-7 
18-20 
18-18 
18-21 

13-8 
14-39 
5-17 

19-5, 19-47 
19-39 

18-9 
6-15 
6-15 

13-8 
13-8 
13-8 
13-8 

6-19, 19-6 
19-16 

18-10 
5-23, 23-2 

19-38 
15-8, 15-10 

15-9 

Volume I contains Chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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DDCMP Timeout 
<Define Search> 
<Delete Block> 
<Delete Bytes> 
DELETE CHAR key 

<Delete Field> 
<Delete File> 
<Delete Filter> 
DELETE LINE key 
<Delete Message> 

<Delete Node> 
<Delete Program> 
Destination Address, IEEE 802.3 
<Detailed Format> 
Disabled hand shaking 

Disc Designations 
Disc Drive Numbers 
Disc drives available 
Disc file syntax 
Disc File Type 

<Disc Functions> Menu 
Disc Number or Name 
Disc Sequence Number 
Discs Supplied With System 
<Display> 

<Display Frame> 
Display, installation 
DSAP 

15-9 
19-14 
14-39 

12-15, 13-5 
1-12 

6-15 
18-7 

12-10 
1-12 
13-4 

11-7 
14-5 

6-18, 19-5 
19-18 

15-6 

18-3 
4-25, 4-27, 4-29 

5-3 
18-22 
18-23 

18-1 
5-18 

18-23 
18-4 

14-27 

14-32, 14-50 
4-16 

19-29 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23 
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<EBCDIC> 
EBCDIC code table 
<EBCDIC> 
<EBCDIC Entry> 
<Edit All Fields> 

<Edit Config.> 
<Edit Datafiel<l> 
<Edit Filters> 
Editing programs 
Editing With Keyboard Keys 
Edit Message example 
<Edit Messages> 
<Edit Modem Str> 
<Edit New Program?> 

<Edit Nodelist> 
adding stations to list 
deleting stations from list 
searching for a node 
sorting the node list 

<Edit Programs> 

Edit Which Program? 
<Else.If> 
<Else When> 
<Enable 1/0> 

Encoded DDCMP: 
<End Edit> 
<Ending With> 
End of Frame 
<Enter New Rev Password> 
<Enter New Xmit Password> 
<Enter Node Name> 
<Enter Rev Password> 
<Enter Xmit Password> 

E 19-34 
Appendix 8 

13-6 
12-16 
12-12 

15-4 
13-5 

12-1, 12-9, 14-43 
14-24 

l-1 l 
13-12 
13-l 

15-15 
14-4 

1 1-1 
11-5 
11-7 
l l-9 
11-8 
14-1 

14-4 
14-41 

14-41, 14-48 
15-19 

15-8, 15-11 
14-14, 14-31, 14-41 

14-12 
19-36 
22-5 
22-5 

12-11, 13-4 
22-10 
22-10 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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Environment, operating 3-2 
<Error Frame> 19-15 
Error, 1/0 15-20 
Error Messages Appendix A 
<Ethernet> I J-4 
<Ethernet Format> 12-17 
Ethernet, frame 6-20 
<Ethernet Header> 19-28 

<Examine Data> 19-1 
Examine Data Display 19-2 

Byte Position 19-6 
Data 19-6 
Destination Address 19-5 
Error 19-5 
Filters 19-4 
Frame Number 19-2 
Message Length 19-3 
Source Address 19-7 
Time Stamp 19-3 
Type 19-7 

<Execute Program> 16-1 
<EXIT> 20-15 

F 
FCS, Bad, Good 12-21 
FCS, selecting an FCS value 13-12 
FCS Field, IEEE 802.3 6-19 
Files, name syntax 18-22 
File space available 18-5 
File type 18-6 
Filter examples 12-24 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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<Filter Format> 
Filter, introduction 
Filter length 
<Filter Matched> 
<Find Block> 
Finding Frames 

<Followed By> 
<Format As Filter #> 

<Format Volume> 

Formatting (Initializing) a Floppy Disc 
Formatting (initializing) a hard disc 
Formatting volumes 
Frame Acquisition vs Display Speed 
<Frame Counter> 
Frame Errors 
Frame filter, Runt 
<Frame Matches> 
Frame match operation precedence 
Frame Number 
<Frames Matching> 
Fuses 

<Go To Block> 
<Go To Byte> 
<Go To Frame #> 
<Go To Trigger> 

<HARDSC (#13)> 

G 

H 

<HARDWARE FUNCTIONS> MENU 
Hardware Handshake: 
<Hex> 
<Hex Data> 
<Hex/Char Data> 
<Hex Entry> 
HP-18 Cables, installation 
HP-18 Cables, part numbers 
Humidity 

19-21 
7-6, 12-2 

12-22 
19-15 
14-38 
19-10 

14-36 
13-9 

18-25 

5-17, 18-25 
5-9' 5-13, 5-15 

18-25 
16-2 

14-29, ] 4-46 
19-42 
21-4 

14-43 
14-44 

17-9, 19-2 
14-7 
4-6 

14-32 
13-7 

19-11 
19-13 

5-10 
21-1 
15-6 

11-10 
19-33 
19-33 
12-16 
4-20 

8-3 
2-7, 3-2 

Volume I contains chapters 1 through 8, appendix A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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IEEE 802.3 Frame 
If commands 
<If Counter> 
<Increment Counter> 
Initializing (formatting) floppy disc 
Initializing (formatting) hard disc 

<Insert Block> 
<Insert Bytes> 
INSERT CHAR key 
<Insert Field> 
INSERT LINE key 
<Insert Node> 

1/0 Functions 
1/0 Run Time Errors 
1/0 Status Messages 

Jabber Frames 

Keyboard, installation 
Keyboard keys 

J 

K 

L 
LAN (Local Area Network), introduction 
LAN terms 

LAN COD 
LANSYS 
Largest space available 
Length Field, IEEE 802.3 

Line voltage select switches 
<List Directory> 
<Load File> 
Loading The System Software 

Manual conventions 
<Mark> 
<Mark Frame> 

M 

6-17, 19-42 
14-25 

14-32, 14-40 
14-31 

5-17, 18-25 
5-9, 5-13, 5-15 

14-39 
12-15, 13-5 

1-12 
12-14 

l-12 
11-5 

15-1 
15-28 
15-20 

19-5, 19-45 

4-14 
1-11 

6-1 
Glossary 

5-3, 18-3 
5-3, 18-3 

18-5 
6-18 

4-4 
18-5 

18-15 
5-5, 5-7 

1-8, l-16 
19-13 
14-33 

Volume I contains chapters 1 through 8, appendices A-D and a glossary. 
Volume II contains chapters 9 through 23. 
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<Marked Frames> 
<Marking Frames> 
<Mark/Unmark> Frame 

Master /Sia ve 
Media Access Units (MAUs) 
Memory Bytes Available 
Message Length 

Misaligned Frame 
Modem errors 
Modem Fl-Duplex 
Modem Hf-Duplex 
Modem string, editing 
Monitor Function 

<Monitor Network> 
Multiple Access 

Network Access Methods 
<Network File> 
Network file name 
<Network Loop Test> 
Network Name, assigning a name 
Network Topology 

Network Type, assigning a type 
<Next Block> 
<Next Frame> 
NEXT key 
<Next Marked> 
<NO> 
Node Address 

N 

18- l 3, 20-13 
14-28 
19-13 

7- l 7, 15-13 
6-l3 
21-3 
19-3 

12-21, 19-5, 19-46 
15-27 

15-7 
15-7 

15-15 
7-16 

17-1, 17-3 
6-15 

6-15 
18-9 
21-8 

21-LO 
11-3 
6-10 

11-4 
14-31, 14-41 

19-11 
1-13 

19-12 
11-7 
11-6 

Volume I contains chapters 1 through 8, appendices A·D and a glossary. 
Volume II contains chapters 9 through 23. 
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Node List 
Node list, adding stations to the list 
Node name 
Node number 
<No Frames> 
<Nonstop> 
<Nonstop Mode> 

<Not> 
<'Not' Byte> 
NULL password 
Numeric entry 

Options for the HP 4971 A 
<Or> 
<Overwrite Nodes> 

Parity Bit: 
<Passwords> Menu 
Peripherals for the HP 497 IS 
<Physical Header> 
Power cords 

Power Requirements 
Preamble, IEEE 802.3 
Preamble length 
Preventative maintenance 
<Previous Frame> 
<Previous Marked> 
PREY key 

<Print Data> 
<Printer Functions> 

Getting Top Of Forms 
Stopping The Printer 

<Print Filters> 
<Print Messages> 
<Print Nodes> 
<Print Programs> 

0 

p 

7-4, 11-1 
11-5 
ll-6 
11-6 
14-7 

14-13 
17-3 

14-43 
12-16 
22-3 
1-16 

2-13 
14-14, 14-44 

18-15 

15-5 
22-l 
2-10 

19-27 
4-11 

2-8, 3-4 
6-18 
21-8 

8-1 
19-11 
19-12 
1-13 

20-10 
20-J 
20-3 
20-4 
20-7 
20-8 
20-6 
20-9 

Volume I contains chapters 1 through 8, appendices A·D and a glossary. 
Volume II contains chapters 9 through 23. 
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<Print The List> 
Print The Screen 

Product Description, HP 497 lS 
Product Information 

Programming examples 
Programming with softkeys 
Program structure 
Protocol 
Protocol Buff er Size: 
Protocol timeout: 
<Purge Node List> 

Range of Frames 
Receive buffer size: 
Received Based Detection 
Receive LED 
Remote disc functions 
Remote printer functions 
Remote protocol: 
<Rename Counters & Timers> 
<Rename Programs> 
<Repeated Times> 

Repeating Displays 
Repeating keys 
Replacement Parts 
<Reset> 
<Reset MAU> 
RETURN key 

<Re-write Existing> 
<Run From Buffer> 
Run from Log-data disc file 
<Run From Network> 
Running Programs 
Runt Frame Filter: 
Runt Frames 

R 

20-14 
20-16 

2-2 
2-1 

14-54 
14-24 
14-24 

15-8 
15-9 
J 5-9 
11-7 

18-12, 20-11 
21-6 
6-16 

16-8, 17-6 
18-28 
20-l 7 

15-8 
14-39 

14-5 
14-35 

17-9 
1-15 
8-3 

14-36 
21-lO 

1-14 

18-9, 18-14 
16-4 
16-5 
16-3 

14-24 
21-4 

12-21, 19-6, 19-44 

.Volume I contains chapters 1 through 8, appendices A·D and a glossary. 
Volume II contains chapters 9 through 23. 
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Safety Classification 
Safety Considerations 
Safety Symbols 

<Save Con fig.> 
<Save File> 
<Save The List> 
<Scroll Frames> 
<Scroll Marked> 
<Search Buff er> 

<Search For Addr> 
<Search For Name> 
<Search For Node #> 
<Search For Pos'n> 
<Search Next> 
<Search Previous> 
<Secure Receiver> 
<Secure Xmitter> 
<Select Bad FCS> 
<Select Data Code> 
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